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Chapter 1: Introduction
This manual covers the setup, operation, and user maintenance of an LD Platform Cart Transporter and cart.
The basic configuration performed using the software that comes with the system is covered.
Full details of that configuration are covered in the Mobile Robot Software Suite User's Guide.

Definitions
Platform: The most basic part of the robot. It includes the chassis, drive assemblies, suspension, wheels, battery, safety scanning laser, obstacle-avoidance lasers, sonar, an on-board
LD Platform core with built-in gyroscope, software needed to navigate, connectors for interfacing with and powering the Operator panel and cart coupling system, Operator panel, and
the platform covers.
LD Platform Cart Transporter: A platform with the LD Platform OEM (including extended
arms) and the coupling plate attached, set up to transport a cart. This is also referred to as just
a transporter.
Cart: A cart, on four casters, that can be attached to an LD Platform Cart Transporter, for
increasing the payload capacity. The cart has brakes on two casters, which can be released
either by coupling with a transporter, or by using a manual brake-release lever on the cart.
AIV (Autonomous Intelligent Vehicle): The LD Platform Cart Transporter with a cart attached
to it. This is the complete mobile robot, which will transport your payload on the cart.
For the initial setup, configuration, and connections, we will refer to the platform.
For controlling or monitoring the full mobile robot, with a cart attached, we will refer to the
AIV.

1.1 Product Description
The LD Platform Cart Transporter is a general-purpose mobile platform designed for moving a
detachable cart indoors and around people. It is self-guided and self-charging, with an automated docking station.
The platform, which moves the cart, comes complete with the ability to know where it is
within your workspace, and to navigate safely and autonomously to any accessible destination
within that workspace, continuously and without human intervention.
The LD Platform Cart Transporter is intended to expand the range of payloads that can be
moved by a platform, both in weight and size.
The LD Platform Cart Transporter is available in two models, designed to transport carts with
a payload up to 105 kg (231 lb) for the LD-105CT and 130 kg (287 lb) for the LD-130CT platform. Where appropriate, differences between the models are called out. Otherwise, this
manual applies to both LD Platform Cart Transporters.
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Figure 1-1. Cart and LD Platform Cart Transporter, Separate

Figure 1-2. Cart and LD Platform Cart Transporter, Coupled
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LD-105CT
LD-130CT
Figure 1-3. LD Platform Cart Transporter Model Labels

LD Platform Cart Transporter
The LD Platform Cart Transporter is a mobile platform, designed for working around people
while moving a cart. It is self-guided and self-charging, with an automated docking station.
The transporter combines hardware and mobile-robotics software to provide an intelligent,
mobile platform to transport your payload on the cart. Its primary guidance uses a safety scanning laser to navigate, comparing the laser readings to a digital map stored on the platform.
The laser is backed up by a gyroscope mounted on the internal core, and encoders and Hall
sensors on each drive wheel.
In addition to the front safety scanning laser, each LD Platform Cart Transporter has two side
lasers, for detecting potential obstacles in its path, a low front laser in the bumper to detect
obstacles lower than the safety scanning laser, and a rear-facing obstacle-detection laser, to
ensure that it is safe for the transporter to back up or turn in place.
For situations that are so dynamic that laser localization becomes difficult, we offer the Acuity
Localization option, which localizes the AIV using an upward-facing camera to recognize overhead lighting patterns. This would apply to areas where objects, such as pallets or carts, are
moved so frequently that they can’t be mapped, or where they block the laser’s view of features that are mapped. This is covered in the LD Platform Peripherals Guide.
Body and Drive

The LD Platform Cart Transporter is relatively small, lightweight, and highly maneuverable. It
has a strong aluminum chassis and solid construction that makes it very durable.
The platform is a two-wheel, differential-drive vehicle, with spring-loaded passive casters front
and rear for balance. The drive-wheels have independent spring-suspension, with solid, foamfilled tires. The wheels are at the mid-line of the platform, so that the platform can turn in
place.
Safety Scanning Laser

The onboard safety scanning laser is a very precise scanning sensor. The laser provides 500
readings in a 240 degree field of view, with a typical maximum range of 15 m (49.2 ft). The
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laser operates in a single plane, positioned at 201 mm (7.9 inches) above the floor. In most
environments, the sensor will provide highly-accurate data.
Glass, mirrors, and other highly-reflective objects cannot be reliably detected by the laser. Caution must be exercised when operating the AIV in areas that have these types of objects. If the
AIV will need to drive in close proximity of these objects, we recommend that you use a combination of markings on the objects, such as tape or painted strips, and also use forbidden sectors in the map, so that the AIV knows to plan paths safely around these objects.
Side Lasers

These two lasers are used to detect obstacles that protrude into the AIV's path, but may not be
detected by the safety scanning laser.
This is needed when obstacles higher than the safety scanning laser (but low enough to be
obstacles) protrude into the AIV‘s path.
Low Front Laser

This laser is mounted to the front bumper. It detects obstacles that are low and in front of the
transporter, such as an empty pallet, which might be too low for the safety scanning laser to
see.
Rear-Facing Laser

This laser gives better coverage of what’s behind the transporter than sonar alone. It is used
during both turning in place and backing up when the transporter and cart are coupled.
Coupling Laser

A laser mounted in the transporter coupling plate is used to locate a triangle on the underside
of the cart’s coupling plate. This is used by the transporter to accurately align with the cart, so
it can couple with it.
Sonar

The LD Platform Cart Transporter’s two rear-facing sonar pairs are for obstacle-sensing while
backing up. The range is up to 5 m (16 ft), though the typical accurate range is only up to 2 m
(10 ft). Each pair consists of one emitter and one receiver. The sonar emitters and receivers are
identical physically, but the transporter uses them differently.
Encoders and Gyroscope

Each wheel has an encoder that tells the navigation system how far the wheel has turned, and
in which direction. Each wheel also has a Hall sensor.
The LD Platform core has a gyroscope mounted on it, to track the AIV's rotation.
The combination of rotation and distance traveled are used by the platform to back up the
safety scanning laser during localization. These limit the area on the platform's map that the
AIV needs to search when localizing.

14
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What’s Included with an LD Platform Cart Transporter
l

One fully-assembled platform
The platform includes a safety scanning laser, a low front laser, two side lasers, a rearfacing laser, and two rear-facing sonar pairs. Each pair is one transmitter and one
receiver.

l

One battery
This is shipped separately from the platform, due to air shipping regulations.
If the battery was shipped by air, it will be at less than 30% charge per IATA regulations.

l

Top plate and coupling plate
The platform top plate covers the payload bay of the platform, and supports the lower
(platform) coupling plate, which engages the cart coupling plate, attached to the cart,
and the coupling laser.

l

LD Platform core, which includes an integrated computer, running Advanced Robotics
Automation Management (ARAM) and a microcontroller with MARC firmware. The
core is housed inside the platform. It also runs the SetNetGo OS.
ARAM and MARC firmware and the SetNetGo OS are pre-loaded on the LD Platform
Core.

l

An HMI Post
This supports the two side lasers and the rear-facing laser, both for obstacle avoidance.
It also supports the Operator Panel.

l

Operator Panel
This includes a touchscreen, an E-Stop button, ON and OFF buttons, a brake-release button, and a keyswitch, which can be locked, and key removed, in either position. The
panel’s frame supports two WiFi antennas and a beacon.
There are LATCH and UNLATCH buttons below the E-Stop.
The optional Acuity Localization camera mounts on top of the Operator panel frame, on
the same plane as the antennas and beacon.

l

Automated docking station
This allows the LD Platform to charge itself, without user intervention. It includes a
wall-mount bracket and a floor plate, for a choice of installation methods. See Installing
the Docking Station on page 47.
A manual charging cord is included, so you can charge a spare battery outside of the
platform.

l

Joystick (option)
This is used for manually controlling the AIV, mostly when making a scan to be used
for generating a map.
At least one joystick is needed for each fleet of AIVs. Once a map is generated, the map
can be shared with multiple AIVs working in the same space.
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Cart
The cart is a frame mounted on four casters, designed so that it can couple with an LD Platform Cart Transporter. Once coupled, the cart moves with the transporter. When the transporter arrives at the intended goal, it uncouples from the cart and leaves, while the cart
remains at the goal. Brakes automatically engage on the cart casters, preventing it from rolling
in case the floor isn’t completely level.
The cart has a manual brake-release lever, so it can be moved manually.

Coupling
The LD Platform Cart Transporter can attach to a cart at a pickup goal, move the cart to a
dropoff goal, and leave it at that goal, with no human intervention.
When the cart and transporter are coupled, the transporter automatically presses a lever that
releases the cart’s brakes, so it is free to move with the transporter.
The coupling system has:
l

a motorized Latching Mechanism

l

a coupling laser
This is mounted in the coupling plate, and is used to align the transporter with the cart
when coupling.

l

LATCH and UNLATCH override buttons, on the Operator Panel

Coupling Plates

Each cart has one coupling plate, and each platform has one coupling plate. The plates are
mounted so that, when the platform moves under the cart, the plates can attach to each other,
allowing the platform to move the cart. The software is aware of whether or not a cart is
attached.
l

l

The cart coupling plate includes a slot that can be latched with the platform coupling
plate. The cart coupling plate is passive.
The platform coupling plate includes a laser, for aligning the platform before coupling,
and a motorized Latching Mechanism, for latching the cart coupling plate.

Optional Components
Refer to Options on page 139 for details.
l

Acuity Navigation
For environments that are very dynamic, such that a map can’t be kept current, or
where the area is too large for the navigation laser to see, Acuity can be used to navigate using overhead light patterns seen with an upward-facing camera.

l

Enterprise Manager 1100
This system manages a fleet of AIVs, for multi-AIV traffic coordination and job management. It includes the Enterprise Manager appliance running the Mobile Software
suite.
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l

Spare battery
A spare battery can be used to minimize down-time. Swapping the battery for a fullycharged battery avoids taking the AIV out of service for more than a few minutes.

l

Call/Door Boxes
These allow an AIV to be requested from a remote location, or allow the AIV system to
control an automated door, so the AIV can pass through it.

User-Supplied Components / System Requirements
PC with Microsoft Windows®
l

Ethernet (wireless preferred)
Wireless is required for a fleet (more than one AIV).

l

100 megabytes of available hard-disk storage

1.2 Software Overview
Mobile Robot Software Suite
The Mobile Robot Software Suite includes all of the software used for platforms and the Enterprise Manager appliance, with the exception of the SetNetGo OS.
ARAM

The Advanced Robotics Automation Management software (ARAM) runs on the LD Platform
core. It operates ranging sensors like the safety scanning laser and sonar, and performs all the
high-level, autonomous robotics functions, including obstacle avoidance, path planning, localization, navigation, and so on, culminating in motion commands to the MARC firmware.
ARAM also controls the battery and light discs, and manages digital and analog I/O, which,
along with platform power, provide for integration of application-specific sensors and effectors
that the user adds.
ARAM manages wired and wireless Ethernet communications with offboard software, for
external monitoring, development, and systems coordination, including coordination of a fleet
of AIVs through the optional Enterprise Manager 1100. It also manages integration with other
systems, as well as external monitoring, setup, and control with the MobilePlanner application.
ARAMCentral

ARAMCentral is the software that runs on the Enterprise Manager appliance. This software
and the appliance combined are referred to as the Enterprise Manager 1100.
For a fleet, the ARAMCentral software manages:
l

the map that all AIVs use

l

the configuration that all AIVs use

l

traffic control of the AIVs
This includes multi-AIV avoidance, destination, standby, and dock control.
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l

queuing of jobs for the AIVs

l

remote I/O, if you are using it

MobilePlanner (licensed)

In order to have your AIV perform autonomous mobile activities, you need to make a map of
its operating space, and configure its operating parameters. The MobilePlanner software is
used to make this map and perform this configuration.
Refer to the separate Mobile Robot Software Suite User's Guide for details on how to map a working space and prepare the virtual elements, goals, routes, and tasks for your application. In particular, refer to:
Working With Map Files > Editing a Map File > Using the Drawing Tools >
Adding Goals and Docks
The MobilePlanner software requires a license to run. You will need at least one license for
MobilePlanner for each fleet of AIVs. Once you generate a map for an area, it can be shared
between multiple AIVs in one fleet.
MobilePlanner, Operator Mode

The MobilePlanner Operator Mode is used to monitor one or more AIV's activities and have
them perform mobile tasks in the mapped space. When MobilePlanner is started without its
license dongle, it automatically starts in this mode. Refer to the separate Mobile Robot Software
Suite User's Guide for details.
Mobile Adept Robot Controller (MARC)

At the lowest level, a microcontroller running MARC firmware handles the details of platform
mobility, including maintaining the platform’s drive speed and heading, as well as acquiring
sensor readings, such as from the encoders and gyroscope, and managing the platform’s emergency stop systems, bumper, and joystick. The MARC firmware computes and reports the platform’s odometry (X, Y, and heading) and a variety of other low-level operating conditions to
ARAM.
Touchscreen Support

Whenever the Mobile Software suite is downloaded, it includes support software for the
optional touchscreen.
Call/Door Box Support

Call/Door boxes have one software component on the box and another on either the Enterprise
Manager 1100 or on the single AIV, when there is no Enterprise Manager 1100.
ARCL Protocol

ARCL is a function of ARAM and ARAMCentral, which is included as part of this suite.
The Advanced Robotics Command Language, or ARCL, is a simple text-based command and
response server for integrating an AIV (or fleet of AIVs) with an external automation system.
ARCL allows you to operate and monitor the AIV, its accessories, and its payload devices over
the network, with or without MobilePlanner.
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SetNetGo
The SetNetGo OS runs on the LD Platform core and Enterprise Manager appliance. It is the
host OS in which ARAM and ARAMCentral run.
The SetNetGo interface in the MobilePlanner software is used for configuring the Ethernet settings for the platform, upgrading software, and performing systems diagnostics, such as
retrieving log files. It can be accessed when connected via the maintenance and management
Ethernet ports, or via wireless Ethernet if enabled.
NOTE: It is possible to connect directly to the SetNetGo OS on a platform through a
web browser. The main intent of this is to allow your IT support to set up the network for you, without using MobilePlanner, which requires a license.

1.3 How Can I Get Help?
Refer to the corporate websites:
http://www.ia.omron.com
and

http://www.adept.com

Related Manuals
This manual covers the installation, setup, operation, and maintenance of an LD Platform Cart
Transporter. There are additional manuals that cover these actions for the platform.
Table 1-1. Related Manuals
Manual Title

Description

Mobile Robot LD Safety
Guide

Contains general safety information for all of our LD Platforms.

Mobile Robot Software
Suite User's Guide

Covers MobilePlanner software, the SetNetGo OS, and most of
the configuration of an LD Platform.

Enterprise Manager
1100 User's Guide

Covers the Enterprise Manager 1100 system, which is hardware
and software used for managing a fleet of AIVs.

LD Platform Peripherals
Guide

Covers peripherals, such as the Touchscreen, Call/Door box, and
Acuity Localization options.

Support
If, after reading this manual, you are having problems with your LD Platform Cart Transporter, contact your local Omron support.
l

l

In the body of your e-mail message, provide your platform’s serial number and describe
the problem you are having in as much detail as possible.
Attach your debuginfo file to the email. Refer to the next section for details on retrieving
your debuginfo file. See the following section for generating your debuginfo file.
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Including a DebugInfo File
If the platform has been set up on a wireless network, skip to SetNetGo Access on page 20.
Network Setup

If the AIV has not been set up on a wireless network, a local area network will have to be set
up on a separate PC, and configured to talk to the AIV over a TCP/IP port. The IP address
should be set to: 1.2.3.5. The Subnet Mask should be 255.255.255.0.
(Windows 7) Start > Control Panel > (Network and Internet >) Network and Sharing Center
> Change adapter settings
Right-click on the LAN Connection, and click on Properties.
From the Properties dialog, scroll to and double-click the Internet Protocol (TCP/IP or
TCP/IPv4) option. In Internet Protocol Properties, click both “Use the following…” radio buttons to enable them, and then type in the IP and netmask values.

Connect the network port of your computer to the platform's Maintenance port. See the figure
Location of Parts in the Payload Bay on page 142.
SetNetGo Access

If the MobilePlanner software is available, use the SetNetGo interface within that software to
access SetNetGo. Otherwise, open a web browser and enter the URL: https://1.2.3.4:
You will be requested to confirm security certificates.

20
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Regardless of how you accessed SetNetGo, you should now have a window similar to the following:

1. From the SetNetGo screen, select:
Status > Debug Info
This will display the “Download debug info” button.
2. Click Download debug info.
3. Save the downloaded file, and attach it to your support request.
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2.1 Dangers, Warnings, Cautions, and Precautions
There are six levels of special alert notation used in this manual. In descending order of
importance, they are:
DANGER: This indicates an imminently hazardous electrical situation which,
if not avoided, will result in death or serious injury.

DANGER: This indicates an imminently hazardous situation which, if not
avoided, will result in death or serious injury.

WARNING: This indicates a potentially hazardous electrical situation which,
if not avoided, could result in serious injury or major damage to the
equipment.

WARNING: This indicates a potentially hazardous situation which, if not
avoided, could result in serious injury or major damage to the equipment.

CAUTION: This indicates a situation which, if not avoided, could result in
minor injury or damage to the equipment.

Precautions for Safe Use: This indicates precautions on what to do and what
not to do to ensure safe use of the product.

2.2 What to Do in an Emergency /Abnormal Situation
Press the E-Stop button (a red push-button on a yellow background) and then follow the
internal procedures of your company or organization for an emergency /abnormal situation. If
a fire occurs, use a type D extinguisher: foam, dry chemical, or CO2 .

Releasing the Brakes
In case of an emergency or abnormal situation, the transporter can be manually moved.
However, only qualified personnel who have read and understood this manual and the Mobile
Robot LD Safety Guide should manually move the transporter. The brakes on the drive wheels
can be released with the brake release button. This requires battery power, and an E-Stop must
be pressed on the transporter.
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NOTE: The LD-130CT has a high gear ratio, and is difficult to move, even with the
brakes released.

Releasing an E-Stop
WARNING: If the AIV’s E-Stop is triggered, ensure that the cause of the EStop is resolved, and all surrounding areas are clear and safe before releasing
the E-Stop.

After the E-Stop button has been manually released, the AIV will wait until the motors are
manually enabled.
There are two ways to enable the motors:
l

l

Using MobilePlanner
Pressing the green ON button on the Operator Panel or the GO button on the Touchscreen

Once the motors are enabled, the transporter will wait two seconds and then resume commanded motion, if there is adequate space to maneuver.

2.3 User's Responsibilities
It is the end-user’s responsibility to ensure that the AIVs are used safely. This includes:
l

l

Reading the installation and operation instructions, as well as the Mobile Robot
LD Safety Guide, before using the equipment.
Ensuring that the environment is suitable for safe operation of the AIV.
If a fleet of AIVs (two or more) is installed, the Enterprise Manager 1100 must be used,
unless no two AIVs will ever operate in the same area.

l

l

Ensuring that anyone working with or near an AIV has been adequately trained, and is
following this user’s guide and the Mobile Robot LD Safety Guide, for safe AIV operation.
Maintaining the AIVs so that their control and safety functions are working properly.

General Hazards
CAUTION: The following situations could result in minor injury or damage to
the equipment.

l

Do not ride on the platform or cart.

l

Do not exceed the maximum weight limit.

l

24

Do not exceed the maximum recommended speed, acceleration, deceleration, or rotation
limits. See Center of Gravity on page 74 and Acceleration, Deceleration, and Rotation Limits
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on page 70.
Rotational speed becomes more significant when the payload’s center of gravity is
farther away (vertically and/or horizontally) from the platform’s center of gravity.
l

l

Do not drop the AIV, run it off a ledge, or otherwise operate it in an irresponsible manner.
Do not allow the AIV to drive through an opening that has an automatic gate/door
unless the door and AIV are configured correctly with the Door Box option.
Refer to the LD Platform Peripherals Guide for details on the Door Box.

l

l

Do not get the AIV wet. Do not expose the AIV to rain or moisture.
Do not continue to run the AIV after hair, yarn, string, or any other items have become
wound around the platform’s axles, casters, or wheels.

l

Do not use parts not authorized by Omron Adept Technologies, Inc.

l

Do not turn on the AIV without the antennas in place.

l

Although the lasers are Class 1 (eye-safe), we recommend you not look directly into
them.

Falling Hazards
WARNING: An AIV can cause serious injury to personnel or damage to itself
or other equipment if it drives off of a ledge, such as a loading dock, or down
stairs.

Physical Barriers

The edge of a loading dock, the entrance to downward stairs, or any other substantial drop
that is within the AIV’s expected operating area should be physically marked so that the AIV’s
navigation laser will see the barrier, and stop before reaching it. The AIV’s navigation laser
scans at 201 mm (7.9 inches) from the floor, so the barrier must cover at least that height.
This needs to be continuous at the site, so that the AIV can’t drive around or through it to the
dropoff.
Logical Barriers

You should also use forbidden areas, sectors, or lines with several feet of safety zone (padding)
before the actual dropoff, to ensure that the AIV will not try to drive there.
These need to be continuous at the site, so that the AIV can’t plan a path to drive around or
between them to the dropoff.

Electrical Hazards
WARNING: The docking station has AC power inside. Its covers are not interlocked.
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l

Do not use power extension cords with the docking station unless properly rated.

l

Never access the interior of the platform with the docking station attached.

l

Immediately disconnect the battery after opening the battery compartment door.
Avoid shorting the battery terminals.

l

l

Do not use any charger not supplied by Omron Adept Technologies, Inc.
If any liquid is spilled on the AIV, power off the AIV, clean up all possible liquid, and
allow the AIV to air dry thoroughly before restoring power.

Pinch Hazards
Latching System Latch

CAUTION: Pinch hazard. The latch of the LD Platform Cart Transporter can
pinch you if you are not careful. Keep your hands clear of the transporter when
it is in action.

Latching System Belt/Pulley

CAUTION: Pinch hazard. During maintenance on the latch mechanism, the
belt and pulley can pinch you if you are not careful. Keep your hands clear of
the belt and pulley when they are in action.

HMI Post-Cart Gap

CAUTION: Pinch hazard. The coupling action of the LD Platform Cart Transporter and cart can pinch you if the cart payload is incorrectly designed, and
you are not careful. Keep your hands clear of the space between the HMI post
and cart when the platform and cart are coupling.
Platform Covers

CAUTION: Pinch hazard. The covers are held in place with strong magnets,
which can pinch you if you are not careful. Follow the instructions in the Maintenance chapter for handling covers.

NOTE: The hazard presented by the platform cover magnets is slight enough that
the covers and their magnets do not have warning labels.
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Magnetic Field Hazards
Platform Covers

WARNING: Magnetic fields can be hazardous to medical implant wearers.
Medical implant wearers stay back 30 cm (12 inches) from the covers, which
are held in place with strong magnets.

Docking Funnel

WARNING: Magnetic fields can be hazardous to medical implant wearers.
Medical implant wearers stay back 30 cm (12 inches) from the underside of the
platform, which is exposed during certain maintenance procedures for which
the platform is tipped on its side.
Cart Magnet

The underside of the cart has a strong magnet, used to signal the LD Platform Cart Transporter
that it is in place. This can be a hazard to medical implant wearers, if they get too close to it.
WARNING: Magnetic fields can be hazardous to medical implant wearers.
Medical implant wearers stay back 30 cm (12 inches) from the bottom of the
cart.

Qualification of Personnel
It is the end-user’s responsibility to ensure that all personnel who will work with or around
AIVs have attended an appropriate Omron training course and have a working knowledge of
the system. The user must provide any necessary additional training for all personnel who
will be working with the system.
As noted in this and the Mobile Robot LD Safety Guide, certain procedures should be performed
only by skilled or instructed persons. For a description of the level of qualification, we use the
standard terms:
l

l

Skilled persons have technical knowledge or sufficient experience to enable them to
avoid the dangers, electrical and/or mechanical
Instructed persons are adequately advised or supervised by skilled persons to enable
them to avoid the dangers, electrical and/or mechanical

All personnel must observe industry-prescribed safety practices during the installation, operation, and testing of all electrically-powered equipment.
WARNING: Before working with the AIV, every entrusted person must confirm that they:
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l

Have the necessary qualifications

l

Have received the guides (both this guide, and the Mobile Robot LD Safety Guide)

l

Have read the guides

l

Understand the guides

l

Will work in the manner specified by the guides

Payload Movement and Transfer
Monitoring and confirmation of the status of AIV payload movement and transfer to or from
facility equipment is the end-user’s responsibility.
Payload transfer problems must trigger an AIV E-Stop, preventing the AIV from moving until
an Operator has resolved the problem and confirmed that the system is safe to use. This handling of payload transfer problems is the end-user’s responsibility.
Providing an interlock between the AIV and facility equipment is the user’s responsibility.

Configurable Warning Buzzer
The LD Platform Cart Transporters have a configurable warning buzzer. It is the user’s
responsibility to configure this buzzer as appropriate for the facility in which the AIV will be
operating. The buzzer will sound whenever the AIV is moving backwards or is turning. Other
situations are configurable.
The buzzer is configured with MobilePlanner, using the following parameters:
NOTE: These parameters are only available with the Mobile Robot Software Suite
5.0 and later.

Table 2-1. Default Parameters
Parameter

Default Setting

DriveWarningEnable

True; If this parameter is set to False, the remaining parameters will not be displayed.
WARNING: Disabling the DriveWarningEnable parameter violates the JIS D 6802
standard. It is strongly recommended that you
leave this set to True.

DoNotWarnDrivingForwards

False

DoNotWarnTurningInPlace

False

DriveWarningLoudMilliseconds

500; If DriveWarningQuietMilliseconds is 0, this parameter is
irrelevant.

DriveWarningQuietMilliseconds 500; This is the length of time between warnings that the
buzzer is silent. Setting this to 0 will cause a continuous warning.
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Multi-AIV Avoidance
When multiple AIVs are operating in the same operating space, they must be connected to an
Enterprise Manager 1100 (EM) via WiFi. The EM helps prevent collisions by sharing AIVs’
dynamic X, Y, Theta, size, and path-planning information with each other. AIVs then factor
this data into their obstacle avoidance. This is not an interlocked method of preventing collisions. Ultimately, it is the end-user/integrator's responsibility to provide an interlocked
method of preventing collisions.
NOTE: If two AIVs are approaching each other, neither will see the other because
the incoming laser beams are detected as reflected beams. Because of this, any
installation with more than one AIV working in the same operating space must be
managed by the same Enterprise Manager 1100.

Traffic Control
A "switchable forbidden area" can be programmed on the map to prevent the AIV from entering an area based on the state of a discrete input. If this input is set from another vehicle, such
as a forklift, while it is in that area, then the AIV will not be allowed to enter that area.

Passing Lanes
Since the LD Platform Cart Transporter technology does not use fixed tracks to guide the AIVs,
the concepts of passing lanes and human safety areas are not relevant.

2.4 Environment
General Environmental Conditions
It is the end-user’s responsibility to ensure that the operating environment of the platform
remains safe for the platform. If there are areas that are not safe for the platform to travel in,
those areas should be physically blocked off so that the platform’s scanning laser will detect
the barriers, and the platform will not attempt to drive there. These areas can also be blocked
off with forbidden zones in the MobilePlanner software, but that should be in addition to physical barriers.

Public Access
The LD Platform Cart Transporter is designed for operating in indoor industrial or professional environments. It must be deployed in a manner that takes into account potential
risks to personnel and equipment. The product is not intended for use in uncontrolled areas
without risk analysis, for example, areas open to general public access. Use in such areas may
require deployment of additional safety measures.

Clearance
The LD Platform Cart Transporter is designed to operate in an environment that is generally
level and has no doors or other restricted areas too narrow for the platform and cart. It is the
user’s responsibility to ensure that adequate clearance is maintained on each side of the AIV,
so that a person cannot get trapped between the AIV and a wall or other fixed object. You
should consult the applicable standards for your area. An exception to side clearance can exist
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at pickup and dropoff locations where the AIV must get close to conveyors or other fixed
objects.
The primary direction of travel of the LD Platform Cart Transporter is forward. When the transporter is turning in place, with no forward movement, the detection of an obstacle in its path
of rotation will not trigger an E-Stop.
WARNING: Personnel who work with or around the transporter should not
stand close to the transporter when it is turning in place (with no forward
motion).

Obstacles
If the LD Platform Cart Transporter will be entering high-traffic areas, the user must take appropriate precautions to alert people in those areas that an AIV might enter. If the traffic consists
of other machines, the user must adjust the AIV‘s and/or the other machine’s parameters to
reduce the risk of a collision.

Safety Scanning Laser Emergency Stop
If an obstacle enters the transporter’s immediate path, the safety scanning laser will trigger an
emergency stop. After the transporter has come to a complete stop, it will wait a minimum of
two seconds before resuming commanded motion, with no human intervention necessary.
l

l

If the obstacle is still in the transporter’s path, it will first attempt to safely path plan
and maneuver around the obstacle, if there is adequate room.
If the transporter can’t simply maneuver around the obstacle, it will search for another
path to reach its goal.
If it can’t find another path, it will wait for human intervention.

2.5 Intended Use
The LD Platform Cart Transporter is not intended for use in any of the following situations:
l

In hazardous (explosive) atmospheres

l

Uncontrolled areas, for example, areas open to general public access.
Application in such areas may require deployment of additional safety measures, and
risk analysis.
LD Platform Cart Transporters are designed for operating in industrial or professional
environments. They must be deployed in a manner that takes into account potential
risks to personnel and equipment.
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l

In the presence of ionizing or non-ionizing radiation

l

In life-support systems

l

In residential installations

l

Where the equipment will be subject to extremes of heat or humidity.

l

In mobile, portable, marine, or aircraft systems
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NOTE: The gyroscope used to assist in navigation in LD Platform Cart Transporters requires a stationary environment for optimum accuracy. Therefore,
we do not recommend them for use on a ship, train, aircraft, or other moving
environment.
WARNING: The instructions for operation, installation, and maintenance given in this guide and the AIV user’s guide must be strictly
observed.

Non-Intended Use
Non-intended use of LD platforms can:
l

Cause injury to personnel

l

Damage the platform or other equipment

l

Reduce system reliability and performance

The body of the AIV must not come into contact with liquids. The drive wheels can tolerate
damp floors, but the body of the AIV must remain dry.
If there is any doubt concerning the application, ask your local Omron support to determine if
it is an intended use or not.

Platform Modifications
If the user or integrator makes any changes to the LD Platform Cart Transporter or cart, it is
their responsibility to ensure that there are no sharp edges, corners, or protrusions.
Note that any change to the platform or cart can lead to loss in safety or functionality. It is the
responsibility of the user or integrator to ensure that all safety features are operational after
modifications.

2.6 Battery Safety
l

Store batteries upright (in an environment with relative humidity less than 70%) at:
l
l

l

l

l

5 to 45°C (41 to 113°F) for up to one month
20 to 25°C (68 to 77°F) for up to one year

Never expose the battery to water.
If the battery is leaking, submerge it in mineral oil and contact your local Omron support.
In case of a fire, use a type D extinguisher: foam, dry chemical, or CO2 .
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2.7 Additional Safety Information

2.7 Additional Safety Information
Accidental Cart Separation
In the unlikely event that the cart becomes unlatched from the platform while in motion, the
brakes are designed to stop the cart within six feet.

Mobile Robot LD Safety Guide
Your local Omron support provides other sources for more safety information:
The Mobile Robot LD Safety Guide provides detailed information on safety for LD Platforms. It
also gives resources for information on relevant standards. It ships with each LD Platform.
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CAUTION: Possible battery damage. Immediately charge the battery to a full
charge upon receipt to avoid the risk of discharging the battery below a usable
state, which would require battery replacement.

Effective April 1, 2016, IATA regulations require that air-shipped lithium ion batteries
(UN 3480, PI 965) must be transported at a state of charge not exceeding 30%. You should
charge the battery completely as soon as you receive it.
NOTE: If the battery was not sent by air, it may be fully-charged.

Overview
In general, setup is the physical preparation of the platform and cart, and physically marking
parking goal locations on your facility floor. Marking the parking goals on the floor is for
human use. An LD Platform Cart Transporter will not use those markings, although we recommend you mark them in any case to prevent someone from placing something there that
would prevent a cart from being parked.
Setup also includes generating a map of the workspace and configuring the AIV with the
MobilePlanner software to perform useful tasks.

Tasks
This overview covers the LD Platform Cart Transporter starter kit, which includes the LD Platform Cart Transporter with all components needed for use including a cart, a docking station,
and the software needed for navigation.
l

Install the battery in the platform. See Installing the Battery on page 43.

l

Fully charge the battery, either outside of or inside the platform.

l

Set up the wireless Ethernet for the platform. See Configuration on page 59.

l

Install the docking station. See Installing the Docking Station on page 47.

l

Install the cart’s manual brake-release cable and lever.

l

Design, build, and install a payload structure, to suit your application. See Payloads on
page 73.
This is the most involved task in getting your AIV working the way you want.

l

Configure the AIV for your environment, so it can perform useful tasks.
This includes generating the map that the platform will use for its navigation. This procedure and parameter configuration is covered in the Mobile Robot Software Suite User's
Guide.

l

Mark the location and orientation of the goals where the cart can be parked. This allows
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a person to place a cart where the transporter can find it.
It will also help keep someone from putting something other than a cart in that area,
which could prevent a cart from being parked in that location.
Configure the MobilePlanner software, so a transporter can pick up and drop off carts.

l

This includes modifying the map that the transporter uses for its navigation. The configuration is covered in the Mobile Robot Software Suite User's Guide.

3.1 Transport and Storage
Use a forklift, pallet jack, or similar device to move the shipping containers.
The containers must always be shipped and stored in an upright position in a clean, dry area
that is free from condensation. Do not lay the containers on their sides or any other nonupright position.

LD Platform Cart Transporter
The LD Platform Cart Transporter system, which includes a cart, is shipped in one crate, along
with the docking station, joystick, and all components except for the battery.
The system must be shipped and stored in a temperature-controlled environment, from 5 to
60°C (41 to 140°F). The recommended humidity range is 5% to 95%, non-condensing. It should
be shipped and stored in the supplied shipping crate, which is designed to prevent damage
from normal shock and vibration. You should protect the crate from excessive shock and vibration.
The transporter alone weighs 81 kg (179 lb).
The crate for the transporter measures 1257 x 1149 x 1645 mm (49.50 x 45.25 x 64.75 inches),
and weighs 129 kg (284 lb). The weight, as shipped, is 230 kg (507 lb).

Battery
NOTE: If you purchased spare batteries, this section applies to them, also.
The battery is shipped in a separate carton, not inside the platform or platform crate.
Storage Requirements

If the battery needs to be stored, the manufacturer recommends:
l
l

5 to 45°C (41 to 113°F) for up to a month
20 to 25°C (68 to 77°F) for up to a year

The battery should start storage fully-charged and upright, in a dry location. If the battery will
be stored for an extended period, it should be recharged periodically to avoid total discharge,
which will damage the battery.
Maintenance

Every six months:
l
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Inspect the battery for damage or leaks.
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l

Place the battery on a charger and allow to fully balance (battery shows all solid LEDs
when fully balanced). Fully recharging a battery every six months is sufficient to keep it
charged enough to avoid damage.

Standalone Cart
Carts can be purchased as an option, if you need more carts than transporters.
The cart box measures 1092 x 635 x 711 mm (43 x 25 x 28 inches). Weights are listed in the following table.
Table 3-1. Item Weights
Item

Weight

Cart

22.7 kg (50 lb)

Cart and Box

28 kg (62 lb)

Cart, Box, and Pallet 44.5 kg (98 lb)

Each cart comes with caster brakes, which require the installation of a brake-release lever. See
Installing the Cart Brake Release on page 52.

3.2 Before Unpacking
Carefully inspect all shipping containers for evidence of damage during transit. If any damage
is indicated, request that the carrier’s agent be present at the time the containers are unpacked.

3.3 Unpacking
Before signing the carrier’s delivery sheet, compare the actual items received (not just the packing slip) with your equipment purchase order. Verify that all items are present and that the
shipment is correct and free of visible damage.
l

l

If the items received do not match the packing slip, or are damaged, do not sign the
receipt.
If the items received do not match your order, please contact your local Omron support
immediately.

Retain the containers and packing materials. These items may be necessary to settle claims or,
at a later date, to relocate the equipment.
A complete LD Platform Cart Transporter will come in two packages:
l

The battery is shipped in a separate cardboard carton.

l

The transporter and cart are shipped in a wooden crate.
This includes the HMI post with the side laser support tubes.
This also includes the joystick, docking station, as well as miscellaneous cords all in a
cardboard carton inside the transporter crate.
NOTE: If extra accessories are ordered, they will be shipped separately.
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Battery
The battery is shipped separately from the transporter. Locate the box that contains the battery
before continuing. Refer to the following figure.

Figure 3-1. Battery Shipping Container
The battery box measures 311 x 540 x 457 mm (12.25 x 21.25 x 18 inches).
NOTE: The battery weighs 19 kg (42 lbs). There are recesses at the front and the
back of the battery, to aid in lifting it.
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LD Platform Cart Transporter

Figure 3-2. Cart and LD Platform Cart Transporter in Crate
The transporter crate measures 1257 x 1149 x 1645 mm (49.50 x 45.25 x 64.75 inches).
Removing the Front Panel

The front panel of the transporter crate doubles as a ramp, for rolling the platform off of the
crate base.
1. Release the latches that hold the front panel to the crate.
There are four spring-loaded latches.
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Figure 3-3. Spring-loaded Latch
2. Remove the front panel, and set it aside.
This will be used as a ramp, to roll the platform off of the crate base.
Removing the Upper Body of the Crate

1. There are six lag bolts and washers around the base of the crate, two in the rear and
two on each side. Remove all six lag bolts and washers.

Figure 3-4. Crate Lag Bolts
2. Slide the upper body of the crate off of the base.
Take care as you slide it over the HMI post, watching the clearance between the crate
and the HMI post components.
The platform will still be held securely by the base of the crate.
CAUTION: Due to the weight and size of the crate upper body, and the
potential to damage the platform during this step, two people should
work together to remove it.
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Removing the Cart

The cart is secured under a wooden panel and a cardboard box.
1. Loosen the restraining strap that is around the cardboard box.
2. Remove the cardboard box.
This contains the dock and the joystick, as well as miscellaneous cords.
If accessories, such as call boxes, are ordered, they will be shipped separately.
3. Release the two spring-loaded latches on either side of the panel that is securing the
cart.

Figure 3-5. Cart Panel Latches
4. Remove the panel and the straps off the top of the cart. Then remove the cart itself.
CAUTION: Due to the weight of the cart, two people should work together to
remove it from the crate.

Removing the Crate Braces

1. Remove the top brace by releasing the four spring-loaded latches, two on either side of
the brace.
2. Remove the front brace by releasing the two spring-loaded latches, one on either side of
the brace.
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Figure 3-6. Crate Braces

Repacking for Relocation
If the LD Platform Cart Transporter or other equipment needs to be relocated, reverse the steps
in the installation procedures in this chapter. Reuse the original packing crates and materials
and follow all safety notes used for installation. Improper packing for shipment will void your
warranty.
The LD Platform Cart Transporter must always be shipped in an upright orientation.

3.4 Setting Up an LD Platform Cart Transporter
The LD Platform Cart Transporter is shipped with the HMI post installed. This includes the
Operator panel at the top of the HMI post. You will have to:
l

Roll the transporter off of the crate, down the ramp
This will be rolling on the casters, not the drive wheels.

l

Remove the pins holding the drive wheels up

l

Install the battery

l

Install the dock, for charging the transporter‘s battery
This should have already been removed from the crate.

l

Set up your wireless system
This is covered in Settings and Configuration on page 59.

Rolling the LD Platform Cart Transporter off of the Crate Base
1. Install the crate front onto the crate base, to serve as a ramp.
There are two hanger bolts that stick up out of the front of the crate base. These fit into
two holes in the end of the ramp. Orient the ramp as shown in Figure 3-7. to ensure
there is a smooth transition between the ramp and the ground.
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2. Roll the transporter off of the crate base and down the ramp.

Figure 3-7. LD Platform Cart Transporter on Crate Base, with Ramp
3. Remove the two wheel pins that held the wheels up during transit.
The wheels are pinned up to protect the motors and drives. When you receive your LD
Platform Cart Transporter, the drive wheels will not touch the ground until you remove
the wheel pins. The wheel pin hole is shown in the following figure.
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Figure 3-8. Wheel Pin Hole Location
For each side of the platform:
a. Remove the side cover a small distance from the platform. Refer to Removing
Covers on page 152.
The light disc PCA cable will still be attached.
b. Disconnect the cable from the light disc PCA, so the side cover can be moved
completely away from the platform.
This will fully expose the wheel and tire.
c. Lift the wheel slightly to relieve pressure on the pin.
d. Remove the pin by pulling the ring that is attached.
These pins can be used for later service of the entire drive assemblies.

Figure 3-9. Wheel Pin
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e. Lower the wheel to the floor.
The wheels are spring-loaded, and the wheel brakes will be on.
f. Put the side cover next to the platform, and attach the light disc cable to the light
disc PCA.
g. Reinstall the side cover.

Installing the Battery
Your platform battery comes with less than 30% charge, to comply with air-shipping regulations. It should be charged as soon as possible, to a full charge.
NOTE: Air shipping regulations require that the tranporter be shipped without the
battery installed.
Removing the Battery Cover

Accessing the battery compartment requires removing the platform's rear cover. This is held in
place with magnets.
CAUTION: Pinch hazard. The magnets holding the cover in place are strong
enough to pinch you if you are not careful.

No tools are needed for either the removal or installation of the battery cover.
NOTE: After removing the cover, place it inner-side down, so the outer surface
doesn't get scratched.
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Figure 3-10. Pulling the Bottom of the Rear Cover Out

Figure 3-11. Lowering the Rear Cover
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Refer to Removing and Installing LD Platform Cart Transporter Covers in the Maintenance section
for cover removal and installation.
1. Remove the inner rear platform cover.
a. Pull the bottom of the cover away from the platform chassis.
This is easiest if you grip it with two hands, toward the center.
b. Lower the cover down, so its top tab clears the rear outer cover.
2. Unlatch and open the battery compartment door, at the back of the platform.
The battery compartment door is capable of being locked. You may need to unlock it.
3. Lift and slide the new battery into the platform body.
The battery weighs 19 kg (42 lbs).
There are recesses at the front and the back of the battery, to aid in lifting it.

Figure 3-12. Battery Recesses, for Gripping
The battery is designed to be lifted and replaced by one person, using one hand in each
of the grips, as shown in the following figure.
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Figure 3-13. Lifting the Battery
The connectors for power and data go toward the rear of the platform.
4. Attach the battery power and data cables to the connectors at the rear of the battery.

Figure 3-14. Battery Cable Connectors
5. Close the battery compartment door to secure the battery in place.
The battery compartment is designed to hold the battery tightly, so that it will not move
within the compartment, once the door is closed.
6. Reinstall the inner rear platform cover.
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Installing the Docking Station
The automated docking station can be used for either manual or automated charging of your
LD Platform Cart Transporter's battery.
The docking station sits on the floor. It can be attached to a wall with the wall bracket,
attached directly to the floor with screws through its base, or it can sit stand-alone on the floor
with the floor plate, all of which will keep the docking station from moving when the transporter docks. Each docking station comes with a wall bracket and floor plate.
CAUTION: It is very important that the docking station be mounted with one
of these methods, or the transporter will simply move the docking station
when it tries to dock, rather than docking successfully.

Regardless of mounting method:
l

l

Locate the docking station near an AC outlet with 1-2 m (3.25-6.5 ft) of clear space in
front to ease the transporter’s maneuvers onto the docking station.
When docked, the rear-facing laser extends almost 5 inches beyond the back of the docking station. Ensure that you leave enough free space behind the back of the docking station to allow clearance for this.
The wall-mount bracket provides enough room for this.

l

The top of the docking station foot is spring-loaded, and lifts off of the bottom of the foot
slightly to accommodate variations in the floor surface. The weight of the transporter
will push the top of the foot down.

Requirements
l

100 to 240 VAC, 50 to 60 Hz, 8 A
The station's power converter automatically detects the source voltage.

l

Ambient operating temperature: 5 to 40°C (41 to 104°F)

l

5% to 95% humidity, non-condensing

Wall Bracket Mount

NOTE: This is the recommended method for mounting the docking station.
1. Attach the docking station mounting bracket to a wall, with the bottom edge of the
bracket 98±20 mm above the floor, using user-supplied anchors and screws. There is leeway, so you can adjust the height a little bit.
Refer to the following figure:
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Figure 3-15. Docking Station, Wall Mount
2. Screw the two shoulder bolts, each with a washer, into the rear of the docking station.
The shoulder bolts are M5 x 4, stainless steel. Their locations are shown in the following figure. Tighten to 9 N·m (80 in-lb).
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Figure 3-16. Rear View of Docking Station with Shoulder Bolts
3. Lower the docking station down, so the two shoulder bolts on the back of the docking
station slide into the bracket, to secure the docking station to the wall.
Floor-mount, without Floor Plate

NOTE: Because this method permanently attaches the dock to the floor, it may be
subject to building code regulations. It is the user’s responsibility to verify that the
installation is in compliance with local regulations.
Screw the base of the docking station directly to the floor, using three user-supplied screws. For
dimensions of the available holes in the base, refer to Figure 3-15. We recommend M5 self-tapping or M4 drywall screws for this.
Floor-mount, with Floor Plate

This mounting method uses the floor plate. The floor plate is not shipped attached to the docking station, so you must attach it for this type of mount. It will be in the crate with the docking
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station.
Attaching the Floor Plate
Refer to the following figures.
1. Tip the docking station onto its back, so you can access the underside.
2. Remove the two lowest screws (M4 x 12 flat-head), if present.
In the following figure, these screws are circled. The location of the third screw hole is
also circled.
3. Attach the floor plate to the base of the docking station with three M4 x 12 flat-head
stainless steel screws.
The floor plate comes with three screws, so you will have two spares.
The docking station and floor plate do not need to be attached to the floor, as the weight of the
platform on the floor plate will keep the docking station from moving.

Figure 3-17. Underside of Docking Station Foot, Showing Screw Locations
NOTE: These are the three locations for the M4 x 12 flat-head screws. Two are
already in place, and need to be removed before attaching the plate.
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Figure 3-18. Docking Station, Mounted on Floor Plate

406

495

Units are mm

Figure 3-19. Docking Station Floor Plate Dimensions
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3.5 Installing the Cart Brake Release

Power On

Install the power cord and turn the power switch to ON. The power switch is next to the
power plug. The blue power LED indicator should light.
Docking Station Contact Adjustment

The contacts on the docking station have five height settings. The station is shipped with the
height in the middle setting, which should be correct in most cases. The height can be changed
by tilting the station enough to see the bottom of the base, making the adjustment accessible.
NOTE: Squeeze and keep the docking station foot against the bottom of the docking
station to make this adjustment easier.
Adjust the height of the contacts by using the pull-knob on the bottom of the dock. The height
changes by 4 mm (0.15 inch) for each notch. See the following figure.
The height of the contacts should be set so that the roller is high enough to stay in contact with
the platform as it is docking, but low enough so that the bi-level of the roller guides the paddle
under the platform.

Figure 3-20. Docking Station Contact Adjusting Pull-Knob

3.5 Installing the Cart Brake Release
The two rear casters of the cart have brakes, which push a blunt pin against the caster rolling
surface to prevent the cart from rolling when it is parked on a floor that is not perfectly level.
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Figure 3-21. Cart Caster Brake, Showing Spring and Pin
To allow an Operator to release the cart brakes when there is no cart LD Platform Cart Transporter present, each cart comes with a brake-release cable and lever, similar to a bicycle hand
brake, that releases the cart brakes when squeezed.
NOTE: The cart brake-release mechanism is actuated by the transporter when it
couples with the cart, so the cart will roll freely with the transporter. This part of the
brake release does not requires any user setup or adjustment.

Installation
The cart brake cable is attached on one end to the cart brake-release mechanism, and outfitted
on the other end with a bicycle-style brake lever, to release the cart’s brakes and allow an Operator to move the cart manually. It is up to the user to mount the brake-release lever at some location on the cart, and route the brake-release cable from the brake-release lever to the actuator.
The brake-release lever comes with a 1524 mm (60 inches) cable. The lever has a clamp the fits
a 22 mm (7/8 inch) tube.
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Figure 3-22. Brake-release Lever
CAUTION: It is important that the brake-release handle be mounted in an
ergonomically-suitable location, so an Operator can repetitively release the
brakes without risking injury.

The actual mounting location and procedure for the brake-release handle are not covered here
due to the variability that is possible in cart structure designs. Ensure that no part of the cart
brake-release cable bends more than a 76 mm (3 inches) radius.
There is a 6.4 mm (0.25 inch) horizontal hole through the rear horizontal tube of the cart. See
the following two figures.

6-mm dia. (0.25-inch dia.) Pass-through hole
for brake cable, through rear frame tube

Figure 3-23. Thru-hole for Brake-release Cable
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Route brake-release
cable up to brake lever
Ø6 mm (0.25 inch) hole
through rear tube wall

Secure brake-release
cable to saddle tie

Figure 3-24. Thru-holes for Brake-release Cable, Plate Removed
After the brake-release lever has been mounted on the cart payload:
1. Push the free end of the lever cable through the hole in the cart’s upper-rear horizontal
tube.
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Figure 3-25. Internal Brake-Release Mechanism
2. Route the cable to the lever cable anchor.
3. Attach the actuator end of the cable to the lever cable anchor.
4. Run the inner wire of the cable around the pulley, through the bushing in the actuator
bar, and through the lever cable clamp.
5. Pull the inner wire tight enough to remove slack, and tighten the lever cable clamp on
it.
6. Cut off the excess inner wire, leaving a small amount protruding past the clamp.
7. Make a service loop of any excess lever cable, at least 152 mm (6 inches) in diameter.
8. Attach the lever cable housing to the saddle tie. See Figure 3-24.

Adjustment
The brake lever cable needs to be adjusted so there is no excess slack, but so the brakes are
engaged when the lever is not being actuated. The two caster brake cables will be adjusted at
the factory.
Brake Lever Cable

The brake lever cable should be adjusted at the lever cable clamp, shown in the preceding figure. There should be just enough slack so the actuator bar touches its hard stop.
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Caster Cables

These should be adjusted correctly from the factory. If any adjustment is needed, refer to the
preceding figure for the adjustment location. The brake pins should be able to go down as far
as the caster surface allows, without any slack. The jam nuts on the two brake adjustments
should be installed using a threadlocker.
Actuator Bar Hard Stop

After the caster cables are adjusted correctly, ensure that the actuator bar just touches its hard
stop. This will keep the actuator bar in position if you have to adjust the lever cable.

14766-000 Rev E

LD Platform Cart Transporter User's Guide

57
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The LD Platform Cart Transporter comes with firmware and on-board software installed.
Configuration of an LD Platform Cart Transporter is done using the MobilePlanner software.
Configuration includes generation of the map that the AIV will use for navigation. The cart
parking goals need to be added to that map. This manual only provides an overview of that
process, which is covered in detail in the Mobile Robot Software Suite User's Guide.
CAUTION: The MobilePlanner dongle, which contains the license for running
the software, should be locked up when not in use, to prevent unauthorized
modifications to your system configuration. The software should be turned off
when not in use.
Other setup, mostly for communication, is handled by the SetNetGo OS, which is accessed
through the MobilePlanner software. It can also be accessed through a direct connection, so
your IT support can set up your wireless without needing the MobilePlanner license.
The transporter navigates using a map, generated with the MobilePlanner software. The operation of this software, as well as the downloading of the resultant map to the platform, is
covered in the Mobile Robot Software Suite User's Guide.
NOTE: The map must be generated and downloaded to the platform before you can
perform the steps covered in this chapter.
By default, the LD Platform Core, safety scanning laser, and some auxiliary power start automatically when you press ON.

4.1 Settings and Configuration
Maintenance Ethernet Connection
To prepare your AIV for autonomous mobile operation, attach a PC to the platform’s Maintenance Ethernet port, and connect with the SetNetGo OS through the MobilePlanner SetNetGo
interface. If you do not have wireless yet, you can connect MobilePlanner through the wired
Ethernet port (Maintenance LAN) and set up the wireless network later.
The LD Platform core is preset and tested on a Class-C network (netmask for all ports
255.255.255.0). The Maintenance Ethernet port is set to IP address 1.2.3.4 and the wireless IP
comes set with an AP-based ("managed") SSID of “Wireless Network”, unsecured. Consult
with your network systems administrator before modifying these network details through the
SetNetGo OS.
The User LAN port is set to IP address 10.10.10.10.
Refer to the Mobile Robot Software Suite User's Guide.
The Maintenance Ethernet port is on the left side of the platform, under the small access panel
at the upper-right corner of the platform. (The joystick port is also there.) The access panel is
held in place with a push-push latch, and retained by a lanyard. See Figure 10-3. This is
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internally connected to the Ethernet port located on the rear side of the LD Platform core in the
payload bay.
The Maintenance Ethernet port is permanently set to IP address 1.2.3.4, with a netmask of
255.255.255.0, for direct, wired access to the onboard systems. Accordingly, when accessing the
port, manually set the offboard computer’s Ethernet to an IP 1.2.3.x, where x is any number 1
through 254 except 4, and with a netmask of 255.255.255.0. No special DNS or gateway settings are needed.
Attach a pass-through or cross-over CAT5 (or better) Ethernet cable between the PC and the
Maintenance Ethernet port of the platform. The platform Ethernet is Auto-MDIX, and will
detect the type of cable you are using.
Start the Network Connections:Local Area Connection dialog for the ETH 0 Ethernet port:
(Windows) Start > Settings > Network Connections > Local Area Connection
Select Properties, and, from its dialog, scroll to and double-click the Internet Protocol (TCP/IP)
option. In the Internet Protocol (TCP/IP) Properties dialog, click both ‘Use the following…’ associated radio buttons to enable them, and then type in the IP and netmask values.

Setting Up Wireless Ethernet
The SetNetGo OS is used to configure the platform wireless Ethernet, among other things. Refer
to the Mobile Robot Software Suite User's Guide for details.
NOTE: Although an LD Platform Cart Transporter is capable of working without
wireless Ethernet if there are no other AIVs that it needs to know about (and to
avoid), that is the exception. In most cases, wireless Ethernet will be needed.
NOTE: For all of the following settings, work with your IT group to verify the correct IP, radio, and security settings.
The following applies to the wireless Ethernet supported by the platform.
The SetNetGo OS is used to configure the wireless Ethernet, among other things. Refer to the
Mobile Robot Software Suite User's Guide for details.
Access the SetNetGo OS through the MobilePlanner software:
MobilePlanner > SetNetGo > Network
NOTE: It is also possible to connect directly to the SetNetGo OS on a platform
through a web browser. The main intent of this is to allow your IT support to set up
the network for you, without using MobilePlanner, which requires a license.
IP Address, Netmask, Gateway, DNS1

Choose Static (DHCP is not recommended), and fill in the IP address, netmask, gateway, and
DNS1, as supplied by your network administrator.
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NOTE: The following settings have to be provided by your IT department.
Radio Settings
l

SSID (e.g. AGV)
Fill in the appropriate wireless SSID for your wireless network.
The SSID is case sensitive.

l

Mode
Managed/STA, Ad-Hoc, or Master/AP

l

Radio Mode
Auto, 802.11a, 802.11b, 802.11g

l

Channel Set

l

Wireless Watchdog IP Address

l

Wireless Watchdog Max Count
0 disables this.

Security Settings

Encryption:
l

Disabled

l

WEP 64-bit

l

WEP 128-bit

l

TKIP/RC4

l

CCMP/AES

l

TKIP/CCMP/AES

Authentication:
l

OPEN

l

WPA-PSK

l

WPA2-PSK

WEP
l

WEP Key Number (Key 1 - Key 4)

l

WEP Keys

WPA/WPA2-PSK
l

PSK

l

PSK-Type (Passphrase or Raw Hex)

Click Apply for your changes to take effect.
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4.2 Mapping

Wireless Coverage

The AIV must have wireless coverage for multi-AIV installations, or in areas where you wish
to send new commands to or receive status updates from the AIV.
Ensure that, in such cases, you have adequate wireless coverage. Because of the variation possible in different environments, we don't specify what components or techniques should be
used to obtain this coverage.
We suggest that you conduct a comprehensive site survey to ensure adequate wireless coverage. You can test the coverage of your wireless setup by trying to ping it from various locations.
>= -40 dBm is the ideal WiFi signal strength, -60 dBm is the recommended minimum.
Bandwidth Considerations

The typical bandwidth in a fleet will average about 50 Kbps/AIV. This would increase if the
AIV is connected to the Enterprise Manager 1100, and is actively viewed by MobilePlanner.
This number can increase or decrease depending on the types of commands and debugging
tools that are enabled in MobilePlanner. In any case, the bandwidth is not likely to exceed 500
Kbps per AIV (0.5 Mbps).
0.5 Mbps per AIV would easily fit within the capabilities of access points (>=54 Mbps). If you
have multiple access points, this number becomes even less of a concern.

4.2 Mapping
There are many options for configuring and tuning your LD Platform Cart Transporter to best
suit your application.
In order to have your transporter perform autonomous mobile activities, you need to make a
map of its operating space. Configuration includes generation of the map that the transporter
will use for navigation. The cart parking goals need to be added to that map. Use the
MobilePlanner application to make the map. This manual only provides an overview of that
process, which is covered in detail in the Mobile Robot Software Suite User's Guide.
Maps may contain a variety of virtual elements which act to modify the behavior of an AIV.
Virtual elements include forbidden lines and areas, speed zones, preferred-direction zones, and
more, all working to help you configure your workspace for efficient and safe performance of
your mobile application. You can also create your own virtual elements for application-specific
AIV-workspace interactions.
Maps contain a variety of goals, routes, and tasks that comprise the destinations and activities
of the AIV in the workspace. There needs to be a goal at every location where you want the
transporter to be able to pick up or drop off a cart. Make sure that the goal orientations leave
room for the platform to maneuver.
The tasks involved are:

62

l

Make a floor plan scan while driving the transporter with the joystick.

l

Load that floor plan scan into MobilePlanner, on your PC, to make and edit the map.

l

Add goals and docks to your map. In particular, refer to:
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Working With Map Files > Editing a Map File >
Using the Drawing Tools > Adding Goals and Docks
in the Mobile Robot Software Suite User's Guide.
l

Transfer the working map to the Enterprise Manager 1100, or back to the platform, if
you have only one platform, to perform autonomous mobile actions.
The Enterprise Manager will automatically download the new map to each AIV in your
fleet as soon the AIV becomes idle.

l

If you have multiple, separate working spaces, which will each require their own map,
you can save map collections and deploy your platform in any of your working spaces
by selecting the appropriate map file.
NOTE: It is a good idea to have the automated docking station installed prior to creating the map scan. Its distinctive front angle will be useful in locating and setting
it up in the map.

Setting Up Cart-Parking Goals
Any location where you want a cart to be picked up or dropped off needs to have a corresponding goal on the map. Pay special attention to the direction of the goals, as the transporter may need extra room to maneuver into the correct position for coupling.

Marking Cart-Parking Goals on Floor
The purpose of marking the parking goals on your floor is so that a human being knows
where to leave a cart, so that the transporter will find it and be able to couple with it.
Even if people will never be moving carts, this step is recommended, so that someone doesn’t
place other items where a cart needs to be parked.
If people will be moving carts, make sure that your markings include the direction of the goal,
so the transporter will be approaching from the correct direction.
The easiest way to accurately mark the goals where a cart may be parked is to send the transporter to each cart-parking goal, and, while the transporter is at the goal, put down tape markings that include the size of the cart, as well as the transporter‘s orientation. The transporter
will always approach the goal from the same direction, so the cart needs to be oriented correctly.

4.3 Configuring a Touchscreen
You configure the touchscreen's appearance and behavior with the MobilePlanner software.
The tasks include setting the mode to use, setting up goals for relocalization, and specifying a
custom screen logo and the language to be used for the display.

Touchscreen Ethernet Setup
The touchscreen plugs into the User LAN port on the platform‘s core.
NOTE: After making and saving changes within User LAN Ethernet Settings, the
platform has to be power-cycled for those changes to take effect. If the only change
is to enable DHCP, then the platform does not have to be power-cycled.
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In the MobilePlanner software, select:
MobilePlanner > SetNetGo
Network > User LAN Ethernet
Ensure that:
l

the IP address subnet doesn’t conflict with the Wireless Ethernet IP subnet

l

Interface mode is set to Accessory

l

DHCP Server for Accessories is set to Enable

l

DHCP IP Range is large enough to provide IP addresses for all connected devices

Figure 4-1. Accessory and DHCP Server for Accessories Enabled

Operating Modes
Specify the touchscreen mode: either Choose Dropoff or Patrol Route.
l

l

Choose Dropoff mode allows the Operator to input the next dropoff goals.
Patrol Route mode simply drives around a specific route. The AIV will have goals that
it stops at, but the Operator will not be able to alter the order of those goals.

For Choose Dropoff, you specify how many dropoff buttons there will be, and how each button
is labeled, as well as the goal on the AIV's map that gets associated with each button.
For Patrol Route, you specify the name of the route and whether to start the patrol on bootup.
The route will include whatever goals the AIV will stop at, and how long it will wait at each
specific goal.
These parameters are accessed from:
MobilePlanner > Config, then Robot Interface > Touchscreen
Select either Choose Dropoff or Patrol Route with the Pages > MainPage parameter, which has
a dropdown selection box.
Choose Dropoff Mode

The following parameters only apply to the Choose Dropoff mode.
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Dropoff Priority

This is accessed under Pages > ChooseDropoffPage.
You can enable high-priority dropoffs, which will be serviced before normal-priority dropoffs.
The Operator can specify that a goal is high-priority when it is being selected for the upcoming
dropoff.
AllowHighPriorityDropoffs
This allows some dropoffs to be specified as high-priority. This is enabled by
default, and you can disable or re-enable it in the MobilePlanner software.
HighDropoffPriority
This is the priority assigned to any dropoff that is specified as high-priority.
Higher priority jobs will be serviced before lower-priority jobs by the queuing
manager. This has no effect if AllowHighPriorityDropoffs is disabled.
Dropoff Buttons

This is accessed under Pages > ChooseDropoffPage.
DropoffButtonCount
This specifies the total number of buttons that will be available on the touchscreen page. You can scroll the page to see other buttons, if all of the buttons cannot be displayed at once.
DropoffButtonx
There will be a DropoffButton1 through DropoffButtonx, where x = DropoffButtonCount. Each contains the two following parameters:
GoalName
This is a combo box that lists all of the goals that have been created
on the map. Select the map goal to be serviced when this dropoff
button is pressed.
NOTE: A goal can have a wait time associated with it,
to give an Operator time to load or unload the AIV. This
is configured, in the map, using the MobilePlanner software.
You can eliminate a button from the screen by making GoalName
blank. The other buttons will fill in, so there will be no blank spaces
in the screen.
ButtonLabel
This is the text label displayed on the dropoff button. If empty, the
GoalName is displayed.
Patrol Route Mode

The following parameters only apply to the Patrol Route mode.
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In this mode you need to specify the name of the Patrol Route that the AIV will patrol. The
route needs to have already been set up using the MobilePlanner software. You also need to
specify if the AIV will start its patrol automatically, or if it requires an Operator to press Go.
Select Pages > PatrolRoutePage
l

l

In RouteName, enter the route to be patrolled.
Check AutoStartRoute for the AIV to start its patrol as soon as the Patrol Route screen is
displayed (the touchscreen has finished booting).

Localization Goals
You need to configure at least one localization goal. You can configure more if you want. A localization goal is needed to relocalize a lost AIV from the touchscreen.
Each localization goal should have:
l

a heading
The AIV will need to be aligned with the heading when relocalizing.
This applies to both laser and Acuity localization.

l

mapped features that don’t change much
Things that get moved frequently, such as pallets, chairs, or carts do not make good
mapped features, because the map will not match what the laser is seeing.

l

mapped features that don’t get blocked
If a mapped wall is often used for stacking boxes or storing carts, the laser may have
trouble seeing the wall behind those objects.

l

multiple visible lights, when using Acuity localization
The more lights the AIV can see, the better.

l

a high localization score
This represents the percent of readings that the AIV currently sees that match the features on its map.
NOTE: Localization goals do not have to be dedicated to localization - they can
also be used as normal goals for regular use.

In MobilePlanner, select:
Config > Robot Interface > Touchscreen
From there, use ChooseLocalizationPage to set LocalizationButtonCount to the number of localization goals you want, and then specify the GoalName and ButtonLabel for each.
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Figure 4-2. Localization Goal Parameters

Screen Logo
In MobilePlanner, select
Config > Robot Interface > Touchscreen
From there, use Style/Appearance.
A logo is displayed in the upper-left corner of the touchscreen. The default logo is Omron, as
shown in the following figure.
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Figure 4-3. Sample Touchscreen, with Omron Logo, in Choose Dropoff Mode
You can customize this with a logo of your choosing using the following steps:
1. Upload a PNG image file to the AIV using the MobilePlanner software:
File > Download/Upload
2. Open the Configuration window and choose:
Robot Interface > Touchscreen
3. Edit the SmallLogo parameter.
a. Click the file-select button to open the file chooser.
b. Select the newly-uploaded file.
c. Click Open.
4. Click Save, to save the configuration.
NOTE: If the SmallLogo field is left blank, the default Omron logo will be displayed.
NOTE: If a different version of the same file name is uploaded to the AIV, you will
need to power cycle the AIV to see the change.

Screensaver
In MobilePlanner, select
Config > Robot Interface > Touchscreen
From there, use Screensaver.
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If the AIV is in motion when the screensaver comes on, it will use the Busy icon, and display
a status message (where it’s going). If the AIV is not in motion, it will display the Available
icon. The rounded rectangle, icon, and any text inside the rectangle will move around the
touchscreen display area.
Screensaver Enabled

This is a checkbox that determines whether a screensaver is displayed when the touchscreen is
inactive. Checking the box enables the screensaver.
TimeoutSeconds

This is the number of seconds that will elapse before the screensaver is turned on. This has no
effect if the Screensaver Enabled box is not checked. The range is 1-999 s.
StayOnTouch

This is a checkbox that determines if touching the screensaver has the same effect as touching
Stay. If this is checked, the AIV will stay when the screensaver is touched.

Display Language
You can select what language is used for the display from a dropdown box in the MobilePlanner software.
NOTE: Some messages from the AIV will be in English, regardless of the language
set here. These include status and mode messages.
From MobilePlanner, select:
Config > Robot Interface > Language/Location
Select RobotLanguage, which has a dropdown selection box.
This parameter is not touchscreen-specific, so it may affect other displays that involve written
language. As of this writing, only the touchscreen is affected. This parameter does not affect
synthesized speech.
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4.4 Acceleration, Deceleration, and Rotation Limits

Contact Information

Figure 4-4. Help Screen, with Contact Information
Help shows installed software and contact information.
NOTE: No contact information will be displayed unless it is set up in the
MobilePlanner software.
In MobilePlanner > Config:
l

Robot Interface > Touchscreen > ContactInformation

l

Check the ShowContactPage checkbox.

l

Enter appropriate information in ContactName and the fields following it.

4.4 Acceleration, Deceleration, and Rotation Limits
Reducing the absolute max allowable linear and rotational acceleration, deceleration, and
speed will affect the size of the allowable CG envelope, but it may do so in non-obvious ways.
For use-cases where the payload can’t be decreased, or the CG can’t be brought within the
recommended limits, Service can work with your system designer to input your needs into our
models.
Contact your local Omron support for details. See Support on page 19.
If your payload’s center of gravity is not within the guidelines given in the Payloads chapter,
you will need to adjust the Absolute Movement Maximums parameters in the MobilePlanner
software.
From the MobilePlanner software, Config:
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Robot Physical > Absolute Movement Maximums
Show Expert + Parameters needs to be checked to see or modify these parameters.
The first two parameters and AbsoluteMaxRotVel are not likely to have significant impact on
the AIV‘s stability. The Accel and Decel parameters will have a major impact. In certain cases,
if the payload is lopsided, the AbsoluteMaxRotVel may need to be adjusted.
The limits and defaults for these parameters are listed in the following table.
Parameter

Default

Min

Max

AbsoluteMaxTransVel (LD-105CT)

1350

1

2500

AbsoluteMaxTransVel (LD-130CT)

900

1

2500

AbsoluteMaxTransNegVel (LD-105CT) -210

-2500 a -1

AbsoluteMaxTransNegVel (LD-130CT) -140

-2500 a -1

AbsoluteMaxTransAccel

1000

1

2000

AbsoluteMaxTransDecel

2000

1

2000

AbsoluteMaxRotVel

180

1

180

AbsoluteMaxRotAccel

360

1

360

AbsoluteMaxRotDecel

360

1

360

a: Although the Min value, in software, is -2500, the hardware safety system on the platform will
generate a fault if the velocity is anything from -300 to -2500 mm/s.

4.5 Supplemental Information
Laser Setup
For most installations, the defaults for the lasers should be appropriate, and will not require
any user adjustment.
The specific parameters for these lasers will come in the model config file that ships on the
unit, or can be provided on request if needed.
l

Laser_1 Settings are for the main scanning laser (S300), used both for safety and localization.

l

Laser_2 Settings are for the low front laser (TiM).

l

Laser_3 Tilted and Laser_4 Tilted are for the side lasers (TiM).

l

Laser_5 Settings are for the coupling laser (TiM).

l

Laser_6 Settings are the rear-facing laser (TiM).
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5.1 Safety
Drive Warning Light
For CE compliance, an AIV is required to have a readily-visible warning light, when it is either
ready to move or is moving. The platform comes with light discs on each side, and the HMI
post has a beacon, designed to be higher than a normal payload, to do this.
If you have a payload that blocks the beacon, the core also provides an output, so you can add
your own warning device. This may be necessary for taller payloads, which may make the
beacon not always visible. The core has a Light Pole connector, which is covered in the Connectivity chapter in LD Platform Core Rear, Upper on page 94. This can be used to drive a warning light in a more prominent location for taller payloads.

Turn Warning Lights
An AIV is also required, for CE compliance, to have readily-visible turn warning lights, when
it is either turning or about to turn. The platform’s light discs indicate that the AIV is turning,
and in which direction.
If you have a payload that blocks the beacon, the core also provides an output, so you can add
your own warning device. This may be necessary for taller payloads, which may make the
beacon not always visible. The core has a Light Pole connector, which is covered in the Connectivity chapter in LD Platform Core Rear, Upper on page 94. This can be used to drive a warning light in a more prominent location for taller payloads.

5.2 Considerations
Dimensions
You must keep your payload no wider and no longer than the LD Platform Cart Transporter.
Take care to keep all of the sensors exposed. If any of the sensors get blocked, the AIV won't be
able to function as intended. This is critical in the case of the lasers.
The payload design must not obstruct the side lasers' field of view.
If you have Acuity localization, you need to make sure that the height of your payload does
not obstruct the camera’s field-of-view. The Acuity camera lens has a 140° field-of-view, so
take care that nothing higher than the camera lens is close beside the camera.

Pinch Hazard
There is a potential, with an improperly-designed cart payload, to create a pinch hazard
between the payload and the HMI post.
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5.2 Considerations

CAUTION: Potential pinch hazard. Ensure that there is enough space between
the HMI post and your payload, when the transporter and cart are coupling,
that it is not a pinch hazard.

Weight
Run-time between charges is a function of payload weight. A heavier payload will result in a
shorter run-time. If you have added any options to the platform that draw power from the platform battery, that will also result in decreased run-time.

Center of Gravity
When adding payload, the center of gravity of the entire cart and payload needs to be considered.
As much as possible, you should keep the payload center of gravity centered on the platform,
and as low (close to the platform top) as possible. This will give you the best stability, particularly when turning or crossing irregularities in the floor.
The payload should be centered on the cart left-to-right, but biased toward the rear of the cart
according to the following plots.
The following figures show the calculations of safe placements for the center of gravity for payloads with the weights listed. The center of gravity, in each instance, needs to be within the
area shown. All units are mm.
WARNING: These figures show centers of gravity for the listed parameter settings only. They do not apply to any other parameter settings. Even small
changes in these parameters can change the safe CG area drastically.
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105 kg

Figure 5-1. Isometric View, 105 kg

Figure 5-2. Longitudinal View, 105 kg
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Figure 5-3. Transverse View, 105 kg

Figure 5-4. Top View, 105 kg
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130 kg

Figure 5-5. Isometric View, 130 kg

Figure 5-6. Longitudinal View, 130 kg
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5.2 Considerations

Figure 5-7. Transverse View, 130 kg

Figure 5-8. Top View, 130 kg
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5.3 Payload-Related Tradeoffs
If you have to extend your center of gravity beyond the guidelines given here, you will need to
adjust various parameters in the MobilePlanner software to compensate for that.
Contact your local Omron support to get a new set of plots based on parameters that differ
from those used to produce the plots shown here.
In general, lowering the maximum accel, decel, and rotation speeds will be required. Refer to
Acceleration, Deceleration, and Rotation Limits on page 70.
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Chapter 6: Connectivity
Most of the connections that are available to the user are in the payload bay, which is the
space between the platform and the platform top plate. These include I/O and power connections. Access to the payload bay is covered in Accessing the Payload Bay on page 150.
For a LD Platform Cart Transporter system, most of these connections will not usually be used.
The two connections outside of the payload bay are the Joystick port and the Maintenance Ethernet port, which are located under a small access panel on the left side of the platform, in the
upper-right corner. Both of these ports connect to the core inside the payload bay.

6.1 Required Connections
Joystick port

l

In order to generate maps with the LD Platform Cart Transporter, you
need to connect a joystick to its Joystick port.
The Joystick port is located under a small access panel on the left side
of the platform, in the upper-right corner.

Maintenance
Ethernet

l

The Maintenance Ethernet port is located under a small access panel
on the left side of the platform, in the upper-right corner.
Its IP address is 1.2.3.4, with Netmask 255.255.255.0.
Access to the SetNetGo OS is always enabled on this interface, and
does not require a password or a license.

l

l

Wireless
Ethernet

For multi-AIV installations, or where you wish to send new commands or receive status updates from the AIV, you need to have wireless Ethernet.

Docking
Station

The AIV needs access to a docking station so it can charge itself. The
docking station needs access to AC power.

6.2 LD Platform Cart Transporter Connections
NOTE: All of these are in the payload bay.
NOTE: If a connection is covered in this subsection, it means that the description in
the subsection Standard Platform Connections on page 86 does not apply to the LD Platform Cart Transporter, because that connection is being used for a cart-specific use.

Core
l

RS232-2 is used for the rear-sensing laser.

l

Both the Debug Port and Aux Power are used by the coupling laser.

l

Digital I/O connector.
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6.2 LD Platform Cart Transporter Connections

The transporter uses pins 9-16, both Input and Output.
Pins 1-8 are available on the cart PCA.
l

User Power is used for cart PCA power.

l

User Interface goes through the PCA to the Operator panel.

l

Aux Sensors is used for both side lasers and the low front laser.

l

Light Pole goes through the PCA to the Operator panel.

l

User LAN goes to the Ethernet switch in the payload bay. Two ports are spares.

Cart-Specific PCA
NOTE: Contact your local Omron support for details.

User
Beeper Out
J56

User EMO Switch
Connector
JP40 JP41 J39

User EMO Out
J13

JP5

J37 User Power
JP26
JP27

User I/O Out 1 - 8
J19 - 26

User I/O In 1 - 8
J40, 45 - 51
J16
User Power Out
J15

JP6, JP7

Figure 6-1. PCA Silkscreen with Callouts
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User E_Stop (USER EMO OUT), J13. Micro MATE-N-LOK, mates with TE 6C 794617-6.
Pin No.

Designation

Notes

1

ESTOP 2A

Dry contact

2

ESTOP 2B

Dry contact

3

BRAKE

Use switch to connect to BATTERY (pin 5)
for external brake release

4

ESTOP CTRLD POWER (BAT) 1 A limit

5

BATTERY

6

GND

1 A limit

User E-Stop Switch (USER EMO SWITCH), J39. Jumpers JP40 and JP41 must be moved to pins
1-2 for this to be functional. MiniFit Jr™, mates with MOLEX 4C 39-01-2045.
Pin No. Designation Notes
1

ESTOP 1A

2

ESTOP 2A

3

ESTOP 1B

4

ESTOP 2B

User Power, J15 & J16. MiniFit Jr™, mates with MOLEX 6C 39-01-2065.
Pin No. Designation

Notes

1

GND

2

GND

3

GND

4

5V

2 A total

5

12 V

1.5 A total

6

BATTERY

22-28 V
1 A total

User Power, J37. Jumper JP5 selects battery (1/2) or E-Stop-controlled battery (2/3).
MiniFit Jr™, mates with MOLEX 4C 39-01-2045.
Pin No. Designation Notes
1

BATTERY

2

GND

3

N.C.

4

SHIELD GND

1.8 A

User I/O Outputs, J19 - J26. Micro MATE-N-LOK, mates with TE 2C 794617-2.
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The return is common for each bank of four outputs, with the indicated jumper.
Connector Designation

Notes

J19

OUT1

JP13, LED DS14

J20

OUT2

JP11, LED DS15

J21

OUT3

JP10, LED DS16

J22

OUT4

JP12, LED DS17

JP26

RETURN

Selects HI or LO for J19-J22

J23

OUT5

JP17, LED DS10

J24

OUT6

JP15, LED DS11

J25

OUT7

JP14, LED DS12

J26

OUT8

JP16, LED DS13

JP27

RETURN

Selects HI or LO for J23-J26

Pin No. Designation
1

RETURN

0 or Battery, 22-29 VDC

2

OUTPUT

HI (BAT) or LO (GND)

Set JP26 and 27 to 2/3 for ACTIVE HIGH OUT
Set remaining jumpers to 2/3 for ACTIVE LOW OUT

OUTPUT HIGH SIDE DRIVERS

NC

1

NC
NC

IO_OUT_2

JP11

6/D5

6/D5
6/D7,6/C3

IO_OUT_3
IO_OUT_4

6/D5

6/D8,6/C3

6/D8,6/C1

IO_OUT6

6/C8,6/C1

IO_OUT_5
IO_OUT_6
IO_OUT_7
IO_OUT_8
NC
NC
NC
NC
NC

1 NC

1
25
2
4
8
10
3
5
7
9
6
11
12

1

OUT_2

6/D6

OUT_3

6/D6

OUT_4

IO_OUT_4

24
23
22
21
20
19
18
17
16
15
14
13

IO_OUT_5
IO_OUT_6
IO_OUT_7
IO_OUT_8

6/C5

OUT5_H_L

JP27

IO_OUT_5

IO_OUT_5

JP15

6/C5
6/C7,6/C1

2

1

1

2

1
2

OUT6_H_L

IO_OUT_6

IO_OUT_6

1

6/C6

2

OUT_6

6/C5

JP14

6/C5
6/C8,6/C1

JP16
6/C8,6/C1

OUT7_H_L

IO_OUT_7

IO_OUT_8

J20
EMO OUT 2
J21
EMO OUT 3
J22
EMO OUT 4

VBAT

OUT_COM_5-8

6/C6

OUT_5
VCC
OUT1
VCC
OUT1
IN1
OUT1
IN2
OUT2
IN3
OUT2
OUT2
IN4
OUT3
ST1
OUT3
ST2
OUT3
ST3
OUT4
ST4
OUT4
OUT4
GND
NC1
NC VNI4140K

2

J19
EMO OUT 1

1

JP17

IO_OUT8

3

1

2

3

IO_OUT_4

9.09K

DS13

1
6/D6

1

IO_OUT_3

2

DS12

IO_OUT7

2

OUT4_H_L

3

DS11

1

1

IO_OUT5

9.09K

IO_OUT_2

2

DS10

9.09K

OUT_1

OUT3_H_L

IO_OUT_3

JP12

VBAT

9.09K

IO_OUT_2

JP10

6/C5

6/D6

OUT2_H_L

1

NC
NC

IO_OUT_1

2

NC

24
23
22
21
20
19
18
17
16
15
14
13

3

IO_OUT_1
IO_OUT_2
IO_OUT_3
IO_OUT_4

VCC
OUT1
VCC
OUT1
IN1
OUT1
IN2
OUT2
IN3
OUT2
OUT2
IN4
OUT3
ST1
OUT3
ST2
OUT3
ST3
OUT4
ST4
OUT4
OUT4
GND
NC1
NC VNI4140K

VBAT

OUT_COM_1-4

1

6/D8,6/C3

1
25
2
4
8
10
3
5
7
9
6
11
12

2

GRN LED GRN LED

1

IO_OUT_1

3

GRN LED

IO_OUT_1

1

GRN LED

IO_OUT4

2

DS17

3

IO_OUT3

2

IO_OUT2

3

DS15

OUT1_H_L

1

JP13

DS14

IO_OUT1

DS16

9.09K

2

JP26

R59

3

9.09K

1

R58

2

9.09K

3

R61

IO_OUT_7

1
6/C6

OUT_7

2

OUT8_H_L

1

9.09K

2

R60

3

VBAT

Notes

IO_OUT_8

1
6/C6

OUT_8

2

J23
EMO OUT 5
J24
EMO OUT 6
J25
EMO OUT 7
J26
EMO OUT 8

Figure 6-2. Output Schematic
User I/O Inputs, J40, J45 - J51. Micro MATE-N-LOK, mates with TE 4C 794617-4.
The return is common for each bank of four inputs, with the indicated jumper.
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Connector Designation
J40

IN1

LED DS26

J45

IN2

LED DS27

J47

IN3

LED DS29

J46

IN4

LED DS28

JP6

RETURN

Selects SINK LO or SOURCE HI
for J40, J45-47

J51

IN5

LED DS33

J50

IN6

LED DS32

J49

IN7

LED DS31

J48

IN8

LED DS30

JP7

RETURN

Selects SINK LO or SOURCE HI
for J48 - J51

Pin No. Designation

14766-000 Rev E

Notes

Notes

1

BATTERY

22-29 VDC, 0.4 A TOTAL

2

GND

HI (BAT) or LO (GND)

3

SENSOR

4

SHIELD GND
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J40

1

16

2
3

15
14

3.9K

4
5

13
12

3.9K

6
7

11
10

3.9K

8

3.9K

2
3

1

4 SHIELD_GND

DS27

J45

VBAT

1

IO_INPUT1

1
IN_1

3

JP6

DS26

1

9.09K

2

VBAT

1 VBAT

9
PS2805_4

2

IN_2

3

1

IO_INPUT2

4 SHIELD_GND

J47

DS29
1 VBAT

Jumpers shown as ACTIVE LOW IN
Move to 2/3 position ACTIVE HIGH IN

2

IN_3

3

1

IO_INPUT3

4 SHIELD_GND

DS28

J46
1 VBAT
2
1

JP7

9.09K

3.9K

DS33

J51
1
2
3

VBAT

1

VBAT

IN_5

1

IO_INPUT4

4 SHIELD_GND

2

3

3

IN_4

1

1

16

2
3

15
14

3.9K

4
5

13
12

3.9K

6
7

11
10

3.9K

8

9
PS2805_4

IO_INPUT5

4 SHIELD_GND

DS32

J50
1 VBAT
2

IN_6

3

1

IO_INPUT6

INPUTS 1-8 Targeted for ACTIVE LOW IN,
9-16 for ACTIVE HIGH IN.

4 SHIELD_GND

J49

DS31

1 VBAT

INPUTS 9-16 Have options for PIC outputs

2

IN_7

3

1

IO_INPUT7

4 SHIELD_GND

J48

DS30
1 VBAT

IN_8

2
3

1

IO_INPUT8

4 SHIELD_GND

Figure 6-3. Input Schematic
User Beeper, J56. Micro MATE-N-LOK, mates with TE 2C 794617-2.
This signal goes low when the platform is moving. It can be used to drive a beeper.
Pin No. Designation

Notes

1

BATTERY

22-29 VDC, 0.1 A

2

SOUNDER

ACTIVE LOW

6.3 Standard Platform Connections
NOTE: All of these are in the payload bay.
If there is no conflicting connection in the Connectivity on page 81, these connections are available for use with standard- and user-supplied accessories. The antennas and joystick come
with the platform.
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NOTE: If a connection is in Connectivity on page 81, it means that the description
here does not apply to the LD Platform Cart Transporter, because that connection is
being used for a cart-specific use.
NOTE: Standard connectors, such as audio, are not covered here. These are on the
right side of the core, shown in the following figure:

Digital Ant1 Ant2
Audio Out
Audio In

Audio Out

Figure 6-4. Right Side of the Core
The left end of the LD Platform core has 12 indicator lights. Their meanings are covered in LD
Platform Core Indicators on page 124.

LD Platform Core Front, Upper

CAN Bus B

Analog I/O

Digital I/O

Aux Sensors

RS232-2

RS232-1

User LAN

Figure 6-5. Front Upper Core
Connection

Type

Description

User LAN

RJ45,
Shielded

General Ethernet, Auto-MDIX.

Aux Sensors

HDB15M

Side lasers

RS-232 x 2

DB9M

Port 1 and Port 2, general use

CAN Bus B

DB9F

Consult Support for use.

Digital I/O (HDB44F)

HDB44F

16 digital inputs, in 4 banks of 4. Each bank can be
wired as active high or active low depending on the
connection of the BANK# terminal.
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6.3 Standard Platform Connections

Connection

Type

Description
VIN range for each input is 0 to 30 V. The input is ON
when VIN > 4 V, OFF when VIN < 1.3 V.
16 digital outputs, protected low-side drivers. These
outputs should be wired to positive voltage through
the load. Output is open when OFF and grounded
when ON. Each open-drain output is capable of sinking 500 mA. May be used with loads connected to
VBAT, AUX_20V, _12V, or _5V. You must stay
within the allowed current capacity of the VBAT or
AUX power supplies.

Analog I/O

HDB15M

General use

CAN Bus B
Connector type

DB9F

Use

CAN Bus

Pin No.

Designation

Notes

1, 4, 8

No Connection

2

CANL_B

CAN Communication differential pair

3, 6

GND

Direct GND

5

SHIELD GND

Bead filter to GND

7

CANH_B

CAN Communication differential pair

9

CANB_12V_OUT_SW 12 V @ 0.5 A Max (switched in SW)

Digital I/O
Connector type

HDB44F

Designation
Pin No.

88

Hardware

Software

Notes

1

INPUT_1.1

Input_1.1

0-30 V Range, Rin = ~3.9 kΩ

2

INPUT_1.2

Input_1.2

0-30 V Range, Rin = ~3.9 kΩ

3

INPUT_1.3

Input_1.3

0-30 V Range, Rin = ~3.9 kΩ

4

INPUT_1.4

Input_1.4

0-30 V Range, Rin = ~3.9 kΩ

5

BANK1

6

INPUT_2.1

Input_2.1

0-30 V Range, Rin = ~3.9 kΩ

7

INPUT_2.2

Input_2.2

0-30 V Range, Rin = ~3.9 kΩ

Common for INPUT_1.X
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Designation
Pin No.

14766-000 Rev E

Hardware

Software

Notes

8

INPUT_2.3

Input_2.3

0-30 V Range, Rin = ~3.9 kΩ

9

INPUT_2.4

Input_2.4

0-30 V Range, Rin = ~3.9 kΩ

10

BANK2

11

INPUT_3.1

Input_3.1

0-30 V Range, Rin = ~3.9 kΩ

12

INPUT_3.2

Input_3.2

0-30 V Range, Rin = ~3.9 kΩ

13

INPUT_3.3

Input_3.3

0-30 V Range, Rin = ~3.9 kΩ

14

INPUT_3.4

Input_3.4

0-30 V Range, Rin = ~3.9 kΩ

15

BANK3

16

INPUT_4.1

Input_4.1

0-30 V Range, Rin = ~3.9 kΩ

17

INPUT_4.2

Input_4.2

0-30 V Range, Rin = ~3.9 kΩ

18

INPUT_4.3

Input_4.3

0-30 V Range, Rin = ~3.9 kΩ

19

INPUT_4.4

Input_4.4

0-30 V Range, Rin = ~3.9 kΩ

20

BANK4

21

OUTPUT_1

Output_1

22

OUTPUT_2

Output_2

23

OUTPUT_3

Output_3

24

OUTPUT_4

Output_4

25

OUTPUT_5

Output_5

26

OUTPUT_6

Output_6

27

OUTPUT_7

Output_7

28

OUTPUT_8

Output_8

29

OUTPUT_9

Output_9

30

OUTPUT_10

Output_10

31

OUTPUT_11

Output_11

32

OUTPUT_12

Output_12

33

OUTPUT_13

Output_13

34

OUTPUT_14

Output_14

35

OUTPUT_15

Output_15

36

OUTPUT_16

Output_16

37

VBAT_IO_OUT4

Common for INPUT_2.X

Common for INPUT_3.X

Common for INPUT_4.X

VBAT @ 0.5 A Max
(shared with light pole)
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Designation
Pin No.

Hardware

Software

Notes

38

VBAT_IO_OUT3

VBAT @ 0.5 A Max

39

VBAT_IO_OUT2

VBAT @ 0.5 A Max

40

VBAT_IO_OUT1

VBAT @ 0.5 A Max

41, 42,
43, 44

GND

Digital Input Specifications
Parameter

Value

Operational voltage range 0 to 30 VDC
OFF state voltage range

0 to 1.3 VDC

ON state voltage range

4 to 30 VDC

Operational current range 0 to 7.5 mA
OFF state current range

0 to 0.5 mA

ON state current range

1.0 to 7.5 mA

Impedance (Vin/Iin)

3.9 kΩ minimum

Current at Vin = +24 VDC Iin ≤ 6 mA

NOTE: The input current specifications are provided for reference. Voltage sources
are typically used to drive the inputs.
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Figure 6-6. Typical Digital Input Wiring Example
Table 6-1. Digital Output Specifications
Parameter
Power supply voltage range

Value
5-30 VDC

Operational current range, per channel Iout ≤ 500 mA

14766-000 Rev E

ON state resistance (Iout = 0.5 A)

Ron ≤ 0.14 Ω @ 85°C

Output leakage current

Iout ≤ 5 μA

DC short circuit current limit

0.7 A ≤ ILIM ≤ 1.7 A
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Standard Equipment
VBAT_IO_OUT4

Outputs 1-16

VBAT_IO_OUT1
OUTPUT_1
OUTPUT_2
OUTPUT_3

(equivalent
circuit)

OUTPUT_4
OUTPUT_5

OUTPUT_16
GND

GND

User-Supplied Equipment
37

Wiring Terminal Block
40

Typical User Loads

21
22
23
24

Load

25

Load

36

Load

41
44

Figure 6-7. Typical Digital Output Wiring Example
Analog I/O
Connector type

HDB15M

Pin No.

Designation

Notes

1

ANALOG_IN1

0-10 V Range

2

ANALOG_IN2

0-10 V Range

3

ANALOG_IN3

0-10 V Range

4

ANALOG_IN4

0-10 V Range

5

ANALOG_IN5

0-30 V Range

6

ANALOG_IN6

0-30 V Range

7

ANALOG_IN7

0-30 V Range

8

ANALOG_IN8

0-30 V Range

9

ANALOG_OUT1 0-20 V Range

10

ANALOG_OUT2 0-20 V Range

11

ANALOG_OUT3 0-20 V Range

12

ANALOG_OUT4 0-20 V Range

13, 14, 15 GND

92

l

The 0-10 V analog inputs have an input impedance of about 35 kΩ.

l

The 0-30 V analog inputs have an input impedance of about 110 kΩ.

l

The analog outputs have an output impedance of about 200 Ω.
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The maximum output current of each analog output is 10 mA. Exceeding the maximum
output current will result in damage to the analog output module.
Aux Sensors
Connector type

HDB15M

Use

Side (vertical) and low sensing (foot) lasers

Designation
Pin No.

Hardware

Software

Notes

1

RS232_VERT1_TXD

/dev/ttyUSB5

2

RS232_VERT2_TXD

/dev/ttyUSB6

3

RS232_FOOT_TXD

/dev/ttyUSB7

4

5V_SW1

USB_1_and_2_Power 5 V @ 1 A (shared with USB port 1)

5, 10

SW_20V_VERT

Vertical_Laser_Power

6, 7, 8

GND

9

5V_SW2

11

RS232_VERT1_RXD

/dev/ttyUSB5

12

RS232_VERT2_RXD

/dev/ttyUSB6

13

RS232_FOOT_RXD

/dev/ttyUSB7

14

5V_SW3

USB_3_Power

5 V @ 1 A (shared with USB port 3)

15

SW_20V_FOOT

Foot_Laser_Power

20 V @ 150 mA

20 V @ 300 mA

USB_1_and_2_Power 5 V @ 1 A (shared with USB port 2)

RS232 1 & 2
Connector type

DB9M

Use

Port 1 and 2, General Use

Pin No.

Designation

Notes

1, 4, 6, 9 No Connection

14766-000 Rev E

2

RS232_USR#_RXD #=1 or 2

3

RS232_USR#_TXD #=1 or 2

5

GND

7

RS232_USR#_RTS

#=1 or 2

8

RS232_USR#_CTS

#=1 or 2
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LD Platform Core Rear, Upper

Light Pole

User Interface User Bumpers Aux Power

Maint LAN

Joystick

User Power

HMI Panel

Sonar 2

Figure 6-8. Rear Upper Core
NOTE: The connectors in the top row of the Rear Upper Core mate with Molex
Mini-Fit Jr™ 5557 series receptacles.
Connection
Light Pole

Type
Mini-Fit 2 x 3

Description
Connects to a user-supplied light tower with 3 lights and 1
buzzer, using a default configuration

NOTE: The following four functions are pins on the User Interface connector.
Brakerelease

Mini-Fit 2 x 7

Pins for user-supplied brake release

ON

Pins for user-supplied ON button

OFF

Pins for user-supplied OFF button

ESTOP

Pins for user-supplied E-Stop (must be used or jumpered)

User
Bumpers

Mini-Fit
2x4

This connection is not used with an LD Platform Cart Transporter.

Aux Power

Mini-Fit
2x3

5, 12, and 20 VDC Outputs

User Power

Mini-Fit
2x6

Battery and switched battery power

Maint LAN

RJ45,
Shielded

Directly connected to the externally-mounted Maintenance
Ethernet, Auto-MDIX.

Joystick

DB9F

Directly connected to the externally-mounted Joystick port

HMI Panel

HDB15F

Operator screen, E-Stop, Brake_Rel, ON, OFF

Sonar 2

DB9M

This connection is not used with an LD Platform Cart Transporter.
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Power Connections

The platform provides conditioned 5, 12, and 20 VDC, and raw (battery) 22 - 30 VDC power to
the platform’s and accessory electronics, including the onboard LD Platform core and safety
scanning laser LIDAR (Light Detection And Ranging).
All power connectors are Mini-Fit®.
Nominal

Qty

Actual

Maximum
Current

Description

5 VDC

1

5±5% VDC

1A

Switched Aux power

12 VDC

1

12±5% VDC

1A

Switched Aux power

20 VDC

1

20±5% VDC

1A

Switched Aux power

22 – 30 VDC

2

battery

4A

Switched

22 – 30 VDC

1*

battery

10 A

Switched

22 – 30 VDC

1*

battery

10 A

Safe, Switched

* 10 A Switched and 10 A Safe, Switched share the 10 A of current.

Each supply has an associated LED, which, when lit, indicates that the port is actively
powered. See LD Platform Core Indicators on page 124.
The Safe 22 - 30 VDC supply automatically gets disconnected when the E-Stop button is
pressed or an obstacle is detected.
Light Pole
Connector type

Mini-Fit® 3 x 2

Use

Light tower (user-supplied)

Pin No.

14766-000 Rev E

Designation

Notes

1

GND

Cable shield

2

LIGHT_P1

Red

3

LIGHT_P2

Yellow or orange

4

VBAT_IO_OUT4 VBAT @ 0.5A Max (shared with DIO)

5

LIGHT_P3

Green

6

LIGHT_P4

Buzzer
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FactorySupplied Equipment
VBAT_IO_OUT4

User-Supplied Equipment
Wiring terminal block
4

Typical user load

LIGHT_P1_N

LIGHT_P2_N
(equivalent
circuit)

LIGHT_P3_N

LIGHT_P4_N

GND

2

3

5

6

1

Figure 6-9. Sample Light Pole Diagram
User Interface
Connector type

Mini-Fit® 7 x 2

Use

Brake release, ON, OFF, E-Stop

Pin No.

96

Designation

Notes

1, 2, 3

FBAT_ALWAYS

Fused VBAT @ 500 mA

4

ESTOP_USR_1L

Short 4 & 11 to close ESTOP_USR_1

5

ESTOP_USR_2L

Short 5 & 12 to close ESTOP_USR_2

6

ESTOP_OUT_1L

Pins 6 & 13 short when ESTOP_CH1 is closed

7

ESTOP_OUT_2L

Pins 7 & 14 short when ESTOP_CH2 is closed

8

OFF_BUTTON

Short to FBAT_ALWAYS to signal OFF (min 1 s pulse)

9

START_BUTTON

Short to FBAT_ALWAYS to signal ON (min 1 s pulse)

10

MOTOR_BRAKE

Short to FBAT_ALWAYS for manual brake release

11

ESTOP_USR_1H Short 4 & 11 to close ESTOP_USR_1

12

ESTOP_USR_2H Short 5 & 12 to close ESTOP_USR_2

13

ESTOP_OUT_1H Pins 6 & 13 short when ESTOP_CH1 is closed

14

ESTOP_OUT_2H Pins 7 & 14 short when ESTOP_CH2 is closed
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NOTE: An E-Stop jumper or a user-supplied E-Stop button needs to be attached to
the E-STOP port on the User Interface connector for the platform to function. The
jumper is provided as part number 12730-000L. An E-Stop button would be usersupplied.
CAUTION: If you are using a user-supplied E-Stop, you must run the Safety
Commissioning to verify the E-Stop’s functionality before putting the AIV into
service.

NOTE: See the following figure.

Figure 6-10. E-Stop Jumper on Platform Core
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Figure 6-11. E-Stop Chain Diagram
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User Bumper

This connection is not used with an LD Platform Cart Transporter.
Aux Power
Mini-Fit® 3 x 2

Connector type

Designation
Pin No.

Hardware

Software

Notes

1, 2, 3

GND

4

AUX_5V_OUT

5

AUX_12V_OUT Aux_12V

12 V @ 1 A max

6

AUX_20V_OUT Aux_20V

20 V @ 1 A max

Aux_5V

5 V @ 1 A max

User Power
Mini-Fit® 6 x 2

Connector type

Designation
Pin No.

Hardware

Software

Notes

1, 2,
3, 4,
5, 6

GND

Limit to < 5 A per pin

7

SW_VBAT_OUT1

Battery_Out_1

VBAT @ 4 A max (switched in SW)

8

SW_VBAT_OUT2

Battery_Out_2

VBAT @ 4 A max (switched in SW)

9, 10*

SW_VBAT_OUT34 Battery_Out_3_and_4 VBAT @ 10 A max (switched in SW).
Limit to < 5 A per pin.

11, 12*

SAFE_VBAT_OUT

SW_VBAT_OUT34 gated by
dual-channel ESTOP relays.

*9,10 and 11,12 share the 10 A of current.
Joystick
Connector type

DB9F

Use

Joystick

14766-000 Rev E

Pin No.

Designation

Notes

1

JOY_XAXIS

Analog X input

2

JOY_YAXIS

Analog Y input

3

JOY_SPEED

Analog SPEED input
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Pin No.

Designation

Notes

4

JOY_GOAL

Goal Button Input

5

JOY_EN_1H

Enable channel 1

6

JOY_EN_2L

Enable channel 2

7

No Connection

8

GND

9

5V

5 V @ 100 mA

HMI Panel
Connector type

HDB15F

Use

Operator screen, E-Stop, Brake_Rel, ON, OFF

NOTE: The HMI panel that this connects to is not the touchscreen used for the LD
Platform Cart Transporter. The HMI panel is not used with the LD Platform Cart
Transporter, so this connector is not used.
Designation
Pin No.

Hardware

Software

Notes

1

RS422_HMI_TX+

2

RS422_HMI_TX-

3

MOTOR_BRAKE

4, 5

ESTOP_FP_1H, _2H

6

RS422_HMI_RX+

7

RS422_HMI_RX-

Connections to HMI Panel

8

START_BUTTON

NOTE: This is not the touchscreen.

9, 10

ESTOP_FP_1L, _2L

11

HMI_5V_SW

12, 14

GND

13

OFF_BUTTON

15

FBAT_ALWAYS

HMI_Power

Sonar 1 & 2

This connection is not used with a cart.
NOTE: Sonar 1 is part of the Internal Core connections.
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Internal LD Platform Core Connections
The following connections are internal (under the platform's top deck), and not normally available for the user. They are listed here so that you can reconnect them in the event that they
need to be disconnected for parts replacement.

Debug

Wheel Lights

Sonar 1

Charge
Contacts

VGA

USB3

USB2

USB1

Bumper Speakers

LIDAR
Batt Comm.

R. Motor L. Motor

Battery
Power

Figure 6-12. Internal Connectors on the LD Platform Core (Front)
Connection

Type

Description

Debug RS-232

DB9M

Reserved

Wheel Lights

DB9F

Motion and status indicator
Light Discs on the platform sides

Sonar 1,
RS-422

DB9M

Connection to Sonar Module
(Rear sonar sensors)

Charge
Contacts

Mini-Fit Sr., 2pin

VGA

HDB15F

Reserved

USB x 3

USB Type A

Reserved

LIDAR

HDB26M

Safety Scanning Laser

14766-000 Rev E
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Connection

Type

Description

Right Motor

HDB26F

NOTE:The Right and Left Motor connectors use
the same type of plug. Take care not to reverse them.

Left Motor

HDB26F

Battery Power

Mini-Fit Sr., 3pin

Battery VDC; connects to battery

Bumper
Switches

Mini-Fit 2 x 4

This connection is not used with a LD Platform Cart Transporter.

Speakers

Mini-Fit 2 x 2

Drives built-in speakers

Battery Comm.

Mini-Fit 2 x 3

Battery communication/control

Core Internal Data Pinouts
Wheel Lights (Light Discs)
Connector type

DB9F

Use

Motion and status indicator Light Discs on the platform sides

Designation
Pin No.

Hardware

Software

Notes

1, 2

CANL_A

CAN Communication differential pair

3, 4

GND

Direct GND

5

SHIELD GND

Bead filter to GND

6, 7

CANH_A

CAN Communication differential pair

8, 9

SW_12V_WHEEL WheelLight_Power 12 V @ 1 A Max (switched in SW)

NOTE: Sonar 1 is covered at the end of Core, Upper Rear.

102

LD Platform Cart Transporter User's Guide

14766-000 Rev E

Chapter 6: Connectivity

LIDAR (Light Detection And Ranging)
Connector type

DB26M

Use

Front safety scanning laser

Designation
Pin No.

Hardware

1

RS422_LIDAR_RX+

2

RS422_LIDAR_RX-

3

OSSD1

4

OSSD2

5

WF_OUT

6

O3_OUT

7

STANDBY

8

EDM

9

No Connection

10, 18

SW_20V_LIDAR

Software

Notes

Main_Laser_Power

Connections to
Factory-Supplied LIDAR

11 thru 17 GND
19

RS422_LIDAR_TX+

20

RS422_LIDAR_TX-

21

IN_A1

22

IN_A2

23

IN_B1

24

IN_B2

25

IN_C1

26

IN_C2

Pin 10 + 18: Current < 600 mA
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LD Platform Core Internal Power Pinouts
Bumper
Connection

Mini-Fit® 4 x 2

Connector type

DB9F

Use

Front bumpers

NOTE: The single front bumper uses four sensors for operation.
Pin No.

Designation

Notes

1

BUMPER_R2L

Right, Channel 2, Low

2

BUMPER_R1L

Right, Channel 1, Low

3

BUMPER_L2L

Left, Channel 2, Low

4

BUMPER_L1L

Left, Channel 1, Low

5

BUMPER_R2H Right, Channel 2, High

6

BUMPER_R1H Right, Channel 1, High

7

BUMPER_L2H Left, Channel 2, High

8

BUMPER_L1H Left, Channel 1, High

Speakers
Connector type

Mini-Fit® 2 x 2

Use

Speakers

Pin No. Designation
1

RIGHT+

2

RIGHT-

3

LEFT+

4

LEFT-

Notes
Right Speaker

Left Speaker
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Batt Comm.
Connector type

Mini-Fit® 3 x 2

Use

Battery control

Pin No.

14766-000 Rev E

Designation

Notes

1

GND

2

RS232_BATT_RXD

3
4

RS232_BATT_TXD Connections to the
Factory-Supplied Battery
FBAT_ALWAYS

5

START_BUTTON

6

OFF_BUTTON
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The Operator panel comprises a touchscreen, an E-Stop button, ON and OFF buttons, a brakerelease (BRAKE) button, a keyswitch, and LATCH and UNLATCH buttons. The panel is mounted on the HMI post, so that it is easily reached by an Operator.

Figure 7-1. Operator Panel, with Acuity Option Shown

7.1 Touchscreen
Touchscreen Initialization
When first powered up, the bottom of the touchscreen will display its boot status.
1. Initializing robot core connection...
NOTE: This may take a minute or two to initialize.
2. Initializing touchscreen software...
3. Connecting to the robot core...
4. Downloading data from the robot core...
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7.1 Touchscreen

Figure 7-2. Screen Initialization Status Display
After initialization, either the Choose Dropoff or Patrol Route screen will be displayed.

Touchscreen Configuration
The behavior of the touchscreen is highly configurable. See Configuring a Touchscreen on page
63.

Screen Top Bar
The top of the screen shows basic AIV information. This includes a bar graph indicating the
WiFi signal strength, the name of the AIV, and the battery state of charge. If the AIV is connected to an Enterprise Manager 1100, it will also be specified here.

Left Screen Pane
The screen logo is displayed in the upper part of the left pane. This doesn’t change, regardless
of the mode you are in. See Screen Logo on page 67.
Below the screen logo, the AIV status is displayed, first graphically, and below that, in text.
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Figure 7-3. Screenshot Showing Top Bar and Left, Right, and Center Panes

Figure 7-4. LD Platform Cart Transporter Status Icons
NOTE: The Busy icon may also include an arrow pointing down, indicating a
pickup, an arrow pointing up, indicating it is doing a dropoff, or an exclamation
mark, indicating an alert condition. Figure 7-3. shows a dropoff.
The bottom of the left side of the touchscreen provides a Stay button, to delay the departure of
the AIV, and a count-down timer, indicating when the AIV will depart.
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Each touch of the Stay button adds 1 minute to the time the AIV will wait before continuing to
its next goal.
l

l

If you touch Stay while the AIV is stopped, it will add 1 minute to the time the AIV is
scheduled to wait before continuing to its next goal.
If you touch Stay while the AIV is moving, it will stop, and stay for 1 minute.
NOTE: The Stay count-down timer can be zeroed at any time by touching Go at the
bottom of the center pane.

The screensaver can be set up to behave the same way the Stay button does, so that touching
the screensaver adds 1 minute to the time the AIV will wait. See Screensaver on page 68.

Right Screen Pane
The right side of the touchscreen displays Home, Dropoffs, Status, and Help tabs. touching one
of these tabs changes the context of the center pane.
Home Tab

NOTE: The Dropoffs tab is not displayed in Patrol Route mode.
The Home tab is used to switch the center pane to show the AIV’s current mission. If an error
condition exists, such as the AIV overheating or being lost, the software will automatically
select the Home tab. See the following figure.

Figure 7-5. Payload Alert, Displayed from the Home Tab
The preceding screen will not be displayed unless the configuration has been set up in the
MobilePlanner software:
Config > Robot Physical > Payload > NumSlots
This must be set to a non-zero value, i.e. the number of payload slots.
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Config > Robot Interface > Payload Present Messages and Behavior
l

l

l

The AlertWhenPayloadNeededForDropoff must be checked.
The PayloadNeededForDropoffShortDescription must have a value. In this case, the
value is “Payload Needed”, which is displayed in the screen’s left pane.
The PayloadNeededForDropoffLongDescription must have a value. In this case, the
value is “The robot has a destination but does not have a payload. Please load an item
or cancel the dropoff.” This will be displayed in the screen’s center pane.
NOTE: The payload parameter section will not be displayed unless the payload slots at the top of the Payload Present Messages and Behavior are set to
a non-zero value.

The Home screen also has an entry for relocalizing a lost AIV from the touchscreen. See Relocalization on page 114.
When you select Home from the right pane tabs (rather than when the software switches to
Home), the center pane will display information about the AIV's current mission, such as the
job details or the current route task.
Dropoffs Tab - Choose Dropoff mode only

Dropoffs shows the available goals, giving the Operator the ability to choose the next goals,
and shows the status of the AIV with respect to the goals it has been assigned.
In Patrol mode, this option isn’t displayed.
Status Tab

After touching the Status tab, you will be given a choice of either Alerts, Robot, I/O, or Peripherals (which accesses screen-cleaning mode).
The number of alert messages that are available for viewing is indicated by a number in a red
circle on the Status button. See the preceding figure.

Figure 7-6. Status Tab and Sub-menu
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Alerts shows an abbreviated list of all active alert messages.

l

Touching on a specific message will display that full message.
Robot shows AIV status, such as the IP address, current task, and its mode.

l

Position Details, within the Robot Status screen, shows the AIV’s position, heading, velocity, and localization score.
I/O will display any of the Core Digital Inputs / Outputs that have been configured as a
“custom” type

l

Figure 7-7. Status > I/O Screen (Top Inputs are not shown in this example)
Peripherals > Touchscreen allows you to lock the touchscreen, so that you can clean the
screen without it interpreting that as input. The screen stays locked for one minute, and
then returns to normal function.

l

Help Tab

Help shows information on the installed software and contact information.
NOTE: No contact information will be displayed unless it is set up in the
MobilePlanner software. See Contact Information on page 70.
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Figure 7-8. Help > Contact Information
Help also provides access the Replay Recorder page.
Replay Recorder

The replay recorder will record data for troubleshooting. Once the start page is opened, you
just touch Start. When you are done recording, touch Stop. The Duration and Replay File fields
are filled in by the recorder. After the recording is completed, use the MobilePlanner software
to download the file generated.

Figure 7-9. Replay Recorder Start Page
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Figure 7-10. Replay Recorder, After Touching Stop

Center Pane
The content of the center pane changes depending on what has been selected from the right
pane. The bottom of the center pane will almost always have a Go button, to zero the Stay
count-down timer, and tell the AIV to proceed to its next goal.

Relocalization
The touchscreen gives you a way to relocalize the AIV if it becomes lost. Before you can do
that, you need to have set up at least one localization goal, with a heading, at which the AIV
can localize. You can set up multiple such goals, if you like. See Localization Goals on page 66.
If the AIV becomes lost, the touchscreen will automatically select the Home tab (from the right
pane), and display a message indicating that the AIV is lost. It will also offer an option to
Recover.
1. Touch Recover.
2. Follow the on-screen instructions.
You will be instructed to manually move the AIV to a localization goal, and then tell
the software which goal you moved the AIV to.

Choose Dropoff Mode
In this mode, the touchscreen communicates with the queuing manager, which then communicates with the AIV.
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Dropoffs

NOTE: Until the queuing manager has been enabled, the touchscreen will not display any of the dropoff goal buttons. Refer to the Mobile Robot Software Suite User's
Guide.
In this mode, the center of the screen displays touch-sensitive dropoff buttons, indicating the
goals associated with them. If there are more buttons than can be displayed at once, a sliver of
the adjacent row of buttons is shown, to indicate their existence. See Screenshot Showing Top Bar
and Left, Right, and Center Panes on page 109.
Navigation of the center pane, when there are more buttons than can be displayed at one time,
is done by touching the screen, between buttons, and dragging the pane up or down.
The color and border of a dropoff button indicate the status of the associated job.
Status

Color

Border

Cancel

Priority

Ready

Blue

None

n/a

n/a

Planned

Dark Blue

None

Yes

Yes

Requested

Dark Blue

None

Yes

Yes

Pending

Dark Blue

Med. Blue

Yes

Yes

In progress

Dark Blue

Green

Yes

No

Interrupted

Dark Blue

Orange

Yes

No

Completed/Canceled

Blue

None

n/a

n/a

The Operator can use this pane for entering the goals where they want the AIV to go for
dropoffs, after leaving its current location.
Touching a dropoff button and then Go requests that the AIV be sent to that goal. Touching
several buttons in sequence, followed by touching Go, requests that the AIV be sent to all of
those goals, in the order in which the dropoff buttons were touched. The order may be altered
by assigning high-priority to any of the goals.
The number of buttons, the content of each button, and the goal associated with each button is
configured with the MobilePlanner software.
l

l

l

Goals will be serviced by the AIV in the order in which you touch their buttons.
The selected dropoff goals are not sent to the queuing manager until you touch Go. After
being received by the queuing manager, each goal is considered to be a job.
Touching a Planned (selected) dropoff button will de-select it, without affecting other
Planned dropoff buttons.
Simply touching a Pending or In-Progress goal button will not affect the associated job.
An explicit Cancel is required to cancel a job in either of those states.

l

Buttons will change appearance when you select/de-select them, change their priority,
when the job is received by the queuing manager, when an AIV is on its way to the button's goal, and when the job is completed (and AIV dismissed).
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Cancel Request (X)

When a dropoff button has a blue or green border, meaning its job is Pending or In Progress,
the Operator can touch the button and a Cancel pop-up button (X) will be displayed on the button. Touching that pop-up will cancel the job for that goal. This does not affect any other jobs.
See Touchscreen Dropoff Goals Page, with Cancel and Hi-Priority Pop-ups on page 116.
High Priority (!)

If you touch-and-hold the dropoff button for a goal that is planned or requested, or simply
touch the button for a job that is pending, a High-Priority pop-up button (!) is displayed. Touching this pop-up will toggle the priority for the goal or job between high and normal priority.
See the following graphic.
When a job is assigned high priority, its dropoff button will display a visible high-priority
indicator (!). A high-priority job will be serviced before all normal-priority jobs, even if those
jobs were entered at an earlier time.
This means that if you touch Goal1, then Goal2+HighPriority, then Goal3, they will be serviced
in this order: Goal2, Goal1, Goal3.
If you de-select a high-priority dropoff button, and then re-select it, it will appear as normal priority (the high-priority flag is not persistent).
NOTE: Changing a high-priority dropoff button or job to normal priority will move
that button or job to the end of the queue, so it will be serviced last.

Figure 7-11. Touchscreen Dropoff Goals Page, with Cancel and Hi-Priority Pop-ups
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Figure 7-12. Touchscreen Dropoff Goals Page, with Stay and Count-down Timer
Stay Button

If the AIV is en route to a goal when Stay is touched, that goal’s button will be turn dark blue
with an orange border.
If the AIV has entered a wait task associated with a goal or job, touching Stay merely extends
that wait, and the button border stays green. (The job isn’t interrupted from the queuing manager’s perspective, the wait task has just been prolonged.)
Go Button

The bottom of the center pane, in Dropoffs and user-selected Home mode, is a Go button. This
zeroes the countdown timer, and causes the AIV to immediately proceed to its next goal. This
can be used in conjunction with the Stay button to pause the AIV, and give the Operator more
time to load or unload the payload.

Patrol Route Mode
The AIV does not communicate with the queuing manager in this mode.
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7.2 Operator Panel

Figure 7-13. Touchscreen, Patrol Route Page, in Stay Mode
An Operator can touch Stay, to pause the AIV, and Go to release it, but the Operator cannot
select the AIV‘s next goal. That is determined by the patrol route.

7.2 Operator Panel
E-Stop Button
When pressed, the red, latching push-button prevents any transporter motion by disabling the
motors. To reset the E-Stop, twist the button slightly, so it pops up.
The motors must be explicitly enabled, either with the dialog box that will pop up (MobilePlanner software with Map > Show Robot on), with the ON button, or with an ARCL command.
See the following figure:

Figure 7-14. Motor Enable Pop-up Dialog
In normal use, the E-Stop button is used for three primary purposes:
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l

You need to interrupt or stop the platform for some reason, to keep it from performing
its currently scheduled task (and don’t have access to MobilePlanner).

l

You are working near the platform and don’t want it to move.

l

You want to use the Brake Release button.
NOTE: There is a two-second delay between the manual release of an E-Stop and
the transporter resuming its activity. During the two seconds, the transporter scans
its path for potential obstacles. It will resume commanded motion provided there is
adequate space to maneuver.

ON Button
The ON button is used for restoring power after the OFF button has been pressed, and the software has finished shutting down the platform.
It can also be used to restore power after an E-Stop has been pressed.

OFF Button
The red OFF button removes power from all systems except the charging hardware circuits.
The platform's software systems prevent loss of data on shutdown, and save the AIV’s last
known location so it automatically localizes when it is next powered on.
NOTE: The OFF button can be disabled by the keyswitch, which can be locked and
the key removed.

Brake-release (BRAKE) Button
The brake-release releases the brakes on the platform. It is used when you need to manually
move the AIV.
Battery power is required and an E-Stop must be pressed to release the brakes.
The BRAKE button must be held in to keep the brakes released.
NOTE: The LD-130CT is difficult to move manually, even using the brake release.

Keyswitch
The keyswitch can be used to disable the OFF button. The key can be removed in either the
locked or unlocked positions.

LATCH Button
The Operator can manually make the platform latch to the cart by pressing this button. The
platform must be in the correct position for latching with the cart for this to work. The button’s
light will be lit blue when this is enabled.

UNLATCH Button
The Operator can manually unlatch the platform from the cart by pressing this button. The button’s light will be lit blue when this is enabled.
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7.3 Other Controls and Indicators
A beacon is mounted on the top of the HMI post. See Operator Panel, with Acuity Option Shown
on page 107.

Light Discs and Beacon
Circular lights on the sides of the platform are used to indicate motion, turns, and several
other states.
A beacon is used to indicate movement and to signal an Operator that the AIV is waiting for
assistance.
Their states are described here, and summarized in the following tables.
Driving Straight

Blue arcs on each side of the platform will appear to rotate in the direction of the platform's
travel, to let nearby people know that it is moving (or about to move). Beacon blinks green.

Turn Signal (for turns >30 degrees)

The blue drive indicators will include a blinking orange segment at the front of one light disc
to indicate that the platform is about to turn in the direction of the signal.
Beacon blinks green.

Stopped, no errors (ready)

Entire light disc on each side pulses blue slowly (0.25 Hz). Beacon is steady green.

Slow pulse:
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Driving with Warning (doesn't prevent driving, such as low battery)

The Light Discs will be orange instead of blue for Stopped, Driving, and Turn Signals.
Beacon alternates green then yellow.

Turn Signal with Warning (doesn't prevent driving, such as low battery)

Same as Turn Signals, but both the blue rotating arc and blinking segment are orange. The
moving arc and the blinking segment have independent timing.

Driving Slowly, Safety Inactive

Under 300 mm/sec, the platform stops safety checking. The pattern is essentially the same as
driving, except the background blinks orange. The moving arc and the blinking segment have
independent timing.

Stopped with Warning (such as low battery)

The light discs will be orange instead of blue for Stopped with Warning. Beacon alternates
long green with short yellow.

Slow pulse:
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Obstacle Detected

The Light Discs will blink yellow if the AIV is stopped for an object in its safety zone. Beacon
blinks yellow.

Lost

When the AIV is lost, the Light Discs will each display two orange arcs, traveling from the 6
o'clock to the 12 o'clock position and back, in opposite directions. Beacon blinks yellow.

Charging

When docked, a green arc will indicate the current state of charge (SOC), showing steady green
from the top of the disc to the current SOC. A small white arc travels back and forth between
the two ends of the green arc. Beacon blinks green (red if E-Stopped).

25%

Left Side

50%

75%

Right Side

100%

State of Charge

0 to 90 cw

0 to 270 ccw

25%

0 to 180 cw

0 to 180 ccw

50%

0 to 270 cw

0 to 90 ccw

75%

full circle

full circle

100%

NOTE: The state of charge displayed is continuous, not limited to 25% increments.
E-Stop

The Light Discs will blink red in an E-Stop condition. Beacon blinks red.
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Booting

When booting, the Light Discs will display two blue arcs, traveling from the 6 o'clock to the 12
o'clock position and back, in opposite directions. Beacon alternates green, yellow, then red.

In the following table:
l

Blink indicates that a disc or light is on for a period, then off for a period.

l

Pulse indicates a 0.25 Hz fade on and off.

l

Circle indicates that the lights appear to be going in a circle.

l

Half-circles indicates two arcs, moving opposite each other between the top and bottom.

l

Solid indicates that a light is on continuously.

l

Alt indicates that the beacon switches between different lights, with no pause. Two
lights with Alt means one light is always on, but not two at once.
Table 7-1. Indicator Meanings
Light Disc
Color

Beacon

Pattern

Color

Meaning
Pattern

Blue

Moving
Circle

Green

Blink

Driving straight,
all ok

Blue/
Orange
@front

Moving
Circle/
Blinking signal

Green

Blink

Turning > 30 degrees
in
direction of orange turn
signal, all ok

Blue

Pulse

Green

Solid

Stopped, all ok

Orange

Moving
Circle

Green
/Yellow

Alt

Drive with warning,
doesn't prevent driving
e.g. low battery

Orange/Orange Moving
@front
Circle/

Green
/Yellow

Alt

Turn with warning
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Light Disc
Color

Beacon

Pattern

Color

Meaning
Pattern

Blinking signal
Blue/
Orange

Moving
Circle/
Blinking signal

Green

Blink

Driving slowly, <300
mm/sec

Orange

Pulse

Green/Green/Green
/Yellow

Alt

Stopped with warning

Yellow

Blink

Yellow

Blink

Object detected in
safety zone

Orange

Left+Right
Half-circles

Yellow

Blink

Lost

Green/White
arc

Partial Circle/moving small arc

Green normally, Red Blink
if E-Stopped

Charging

Red

Blink

Red

Blink

E-Stop, stops driving

Blue

Left+Right
Half-circles

Green/Yellow/Red

Alt

Booting

LD Platform Core Indicators
The left end of the LD Platform core has 12 indicator lights.

Figure 7-15. Core Indicator Lights
The following table gives their meanings:
Indicator

Meaning

Left Column
LOGIC
PC

The microcontroller has power
The LD Platform core and the servo controller are communicating

DRIVE

The drive wheels are under servo control

ESTOP

An E-Stop has been activated

Middle Column

124

LD Platform Cart Transporter User's Guide

14766-000 Rev E

Chapter 7: Operator Interface

Indicator

Meaning

20V

20 V power is available

12V

12 V power is available

5V
VBAT

5 V power is available
Raw battery power is available

Right Column
LAN MAINT The Maintenance Ethernet connector is showing activity
LAN USER
WLAN
HD

The USER LAN connector is showing activity
The WiFi is showing activity
The hard drive is showing activity

Battery and Docking Station
For the battery, see Battery Indicators and Controls on page 130.
For the docking station, see Docking Station on page 131.
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Chapter 8: Operation
Before proceeding, you need to have performed the steps covered in the Setup and Configuration chapters, so your platform has a map to work from.

8.1 Operating Environment
Intended Use
The LD Platform Cart Transporter is designed for operating in indoor industrial or professional environments. It must be deployed in a manner that takes into account potential
risks to personnel and equipment. The product is not intended for use in uncontrolled areas
without risk analysis, for example, areas open to general public access. Use in such areas may
require deployment of additional safety measures.

Clearance
The LD Platform Cart Transporter is designed to operate in an environment that is level and
has no doors or other restricted areas too narrow for the cart or transporter.
It is the user’s responsibility to ensure that adequate clearance is maintained on each side of
the AIV, so that a person cannot get trapped between the AIV and a wall or other fixed object.
You should consult the applicable standards for your area.
An exception to side clearance can exist at pickup and dropoff locations, where the AIV must
get close to conveyors or other fixed objects.
WARNING: Do not allow the AIV to drive through an opening that has an
automatic gate or door unless the door and AIV are configured correctly with
the Door Box option.

Refer to the LD Platform Peripherals Guide for details on the Call/Door Box.

Obstacles
If the AIV will be entering high-traffic areas, the user must take appropriate precautions to
alert people in those areas that an AIV might enter. If the traffic consists of other machines, the
user must adjust the AIV‘s and/or the other machine’s parameters to reduce the risk of a collision.
Care must be taken to avoid:
l

glass doors and walls

l

pits without railings or low bumpers

l

floors with access panels removed

l

loose cables, hoses, etc.
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This specifically includes wires hanging from above the AIV, which could pose a
hazard if the AIV ran into them.
l

large, highly-reflective objects

Environment and Floor
Floors must be level and provide good traction, typical of good walking conditions.
l

Temperature

5 to 40°C (41 to 104°F)

l

Humidity

5% to 95%, non-condensing

l

Altitude

Up to 1000 m above mean sea level

NOTE: Read the warning that follows step and gap traversal.
Any steps must have a smooth, rounded profile.
l

Step traversal

Up to 5 mm (0.2 inch) at 250 mm/s only

l

Gap traversal

Up to 5 mm (0.2 inch) at 250 mm/s only

WARNING: The transporter with cart is designed and intended for smooth,
level floors. While it is capable of driving over a step or gap as listed, frequent
or high-speed driving over steps or gaps will shorten the lifespan of the drivetrain components.
NOTE: At less than the recommended speed, the LD Platform Cart Transporter may
not be able to traverse the step height listed.
The LD Platform Cart Transporter is not intended for use in hazardous environments (explosive gas, water, dust, oil mist). It has an IP rating of IP20.
The LD Platform Cart Transporter is not intended for use in the presence of ionizing or nonionizing radiation.

Platform Getting Stuck
It is possible, though not likely, for the platform to get into a position from which it cannot
move without Operator assistance.
Some examples are shown in the following figure.
If the platform has to be lifted to be free to drive again, refer to Lifting the Platform Safely on page
143.
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Platform Stuck Under Overhang
Platform Driven off Ledge

AIV Stuck Under Overhang
Platform Driven Over Excessive Gap

Figure 8-1. Platform/AIV Getting Stuck Examples

Cart Getting Stuck on Platform
To remove a cart that is stuck in the latched position:
1. Power off the cart transporter completely.
2. Press and hold the Unlatch button on the Operator panel until the transporter is fully
unlatched. It should take about 5 seconds for the latch to start moving.

8.2 Typical Operation
During normal startup, your platform powers all its onboard systems1 and runs its onboard
software automatically to provide an application-ready AIV. If it has been given a map of its
workspace and knows where it is within that environment (localized), your AIV is ready to
perform on startup and will operate autonomously, without human intervention.
Paths are not pre-programmed, but instead are generated dynamically onboard the platform.
Paths are updated many times per second to maintain a smooth trajectory and to account for
any obstacles that are detected by the onboard sensors. Navigational parameters are stored
onboard the platform, and can be viewed and modified using the MobilePlanner software,
which is covered in the Mobile Robot Software Suite User's Guide.
The MobilePlanner application, running on your computer, is used to configure the many
high-level operating characteristics of the platform, including speeds and accelerations, sensor

1As configured either by the factory or through your own parameter changes.
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safety zones, minimum battery level allowed before docking for recharging, which map to use,
and many other parameters. The MobilePlanner software typically communicates with the platform over the wireless network. A direct connection, through the Maintenance Ethernet port on
the platform, is also possible.
CAUTION: The Operator Mode of the MobilePlanner software, which does
not require a license to run, should be protected with user ID and password
access, to prevent unauthorized operation of an AIV.

8.3 Power and Charging
The platform battery supplies ample power for the motors, electronics, and accessories.
The platform ships separately from the battery. The battery is shipped at less than 30% charge,
to comply with air-shipping regulations. You should have installed the battery in the platform
in Installing the Battery on page 43. You should fully-charge it as soon as possible, to avoid battery damage from a full discharge.
Battery recharging is typically managed by the platform. With ample power, as is provided by
the automated docking station, all onboard systems function continuously while the battery
recharges.
The Operator screen shows % state-of-charge (SOC) remaining for battery.
Run-time, with no load, is approximately 15 hours. This will vary significantly depending on
operating conditions.
Recharge time is approximately 4 hours.

Battery Indicators and Controls
The battery has (from left to right) four green LEDs, and one push-button (labeled
SHOW LEVEL). The firmware scans LEDs 1 through 4, back and forth, one at a time. From left
to right, they indicate:
LED

Color

Meaning

Red

Error condition a

Green

25% state of chargeb

2

Green

50% state of charge

3

Green

75% state of charge

4

Green

100% state of chargec

a:

If the red light blinks after pressing the SHOW LEVEL button, the battery is depleted and
needs a recharge.

1

If the red light blinks constantly, the battery needs service. Connecting the battery to a
platform will write an error code to the log, which will allow Service to better
troubleshoot the problem.
b:

While powered up, the LEDs scan back and forth from 1-4.

c:

When on the docking station, blinks when battery pack balances. When balancing is
complete, all LEDs light solid.
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Figure 8-2. Battery LEDs, Push-Button, Power Cable, and Data Cable
Pushing the "SHOW LEVEL" button displays the battery's state of charge. This can be useful
when a battery is in storage, and you want to know its state of charge.
NOTE: After pressing the SHOW LEVEL push button, the battery will display the
state of charge for a brief time, then go back to scanning back and forth on LED at a
time. It will continue doing this for 4 hours, until it powers itself off. To turn off the
pack manually, press and hold the push button for 10 seconds.

Docking Station
The automated docking station is both a manual and an automated means for recharging your
platform battery.
Autonomous Charging

During normal, autonomous operation of the AIV in the workspace, the platform manages
charging automatically through the automated docking station. The platform will approach
the docking station frontward, and then turn around and back onto the docking station to
charge. There is about a 10-s delay between when a platform docks and when the charging
LED turns on.
Connecting and disconnecting the platform with network and onboard clients will not disturb
the charging state. (Moving the platform will, of course.) The station supplies ample power for
all onboard systems while charging its battery, so you can continue operating those systems
while charging.
If the platform is powered off, it will turn on automatically when it is pushed onto the docking
station. A platform cannot be turned off while on the docking station.
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Figure 8-3. Docking Station
Indicators, Controls, and Connections

The docking station has a power switch and two LEDs:
l

blue indicates that power is available.

l

yellow indicates that a charge is in progress.

The power switch, located on the right side of the dock, has an integrated thermal fuse, which
can shut down the dock if it becomes too hot. If this happens, you have to wait for the fuse to
cool down, toggle the switch to off (0) and then back to on (1).
The power plug for AC supply is next to the power switch. Power requirements are 100-240
VAC, 50-60 Hz, and 8 A.
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The plug for connecting the manual charging cable is on the left side of the station, as viewed
from the front.
Environmental Requirements
l

Ambient temperature range: 5 to 40°C (41 to 104°F)

l

Humidity: 5% to 95% non-condensing

Maintenance

The docking station contacts should be cleaned quarterly with isopropyl alcohol. See Docking
Station Contacts on page 150.
The guide roller can be replaced in the field. See Docking Station Roller and Bearing on page 159.
If necessary, the height of the docking station contacts can be adjusted. See Docking Station
Contact Adjustment on page 52.

Manually Charging the Battery
Battery in Platform

To manually charge a battery inside the platform, push the platform backwards, with E-STOP
engaged, so that the rear of the platform slides over the contacts of the docking station.
There is about a 10-s delay between when the platform is in position and when the charging
LED turns on.
NOTE: You will need to press and hold the brake release button before moving the
platform.
NOTE: If you push the platform too far onto the docking station, it will not charge.
Make sure that the yellow charge light comes on and stays on.
Standalone Battery

The battery can be charged, outside of the platform, by using the connector on the left side of
the docking station (viewed from the front) with the provided charging cable. This will most
likely be used for charging a spare battery, while a second battery is still in the platform, and
the platform is in use. Some users choose to manually charge a spare battery, and swap that
for the battery inside the platform.
There is about a 10-s delay between when you connect the battery cable and when the charging LED turns on.
NOTE: The docking station cannot charge a platform and a separate battery at the
same time. If a platform is on the station, the power to the manual charge connector
is cut off.

Balancing the Battery
The platform battery is composed of multiple cells, which need to stay balanced in order to
maintain maximum run-time.
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There are three ways for managing battery balancing:
l

Set the platform‘s DockUntilDoneCharging parameter to True. In this case, the battery
will balance before saying it's done charging, so the battery will get balanced every time
the platform docks. You do not have to do anything extra to balance the battery.
In this mode, the battery will typically take about 10 minutes to balance after charging.
NOTE: This is the mode that is recommended for platforms that aren't doing
battery swapping.

l

Exchange the in-service battery, periodically, with a fully-charged spare battery.
A spare battery that remains plugged into a docking station will be balanced. In this
mode, you don’t have to worry about battery balancing, although it does add the task of
manually swapping batteries.
The interval between battery swaps depends on how the AIV is used. This includes the
weight it carries, and what percent of the time it is in service. You will need to determine the best interval for your situation. Swapping the battery at every shift change is a
commonly-used interval.
NOTE: This is the mode that is recommended for battery swapping, if you
are not charging the battery while it is inside the platform.

l

Set the platform’s DockUntilDoneCharging parameter to False, to let the platform get a
partial charge by docking. The StateOfChargeToChargeTo and MinutesToChargeFor
parameters need to be set to appropriate (non-zero) values. You would then do a battery
swap with a fully-charged and balanced battery periodically, such as once a week.
o

StateOfChargeToChargeTo determines the state of charge the battery needs to
attain before the platform can stop charging.
A 90% value here would get the battery mostly charged, but not balanced.

o

MinutesToChargeFor determines the number of minutes the battery needs to
charge before the platform can stop charging.
The platform will stop charging when the battery reaches either of these parameter values.
CAUTION: If both of these parameters are left at the default of 0, and
DockUntilDoneCharging is set to False, the platform will dock, and
never undock.

We recommend that you do a battery swap weekly, at a minimum. If you see a reduction in run-time, you should do a swap more often than that.
NOTE: The longer you wait to balance a battery, the longer it will take to balance. A battery that is badly out of balance can take well over 10 hours to balance after charging.
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8.4 Startup
Procedure
Press and hold the ON button for 0.5 s, then release. It takes about a minute for all the systems
to start up and make their various interconnections. If the platform doesn't start up, try power
OFF, check your connections, and then power ON.
Startup is complete when the Light Discs stop indicating boot (two blue light segments, moving in opposite directions from 6 o'clock to 12 o'clock and back).

Joystick
The joystick lets you quickly move the platform to its destination. This can be used to drive it
from the shipping dock to an automated docking station.
CAUTION: The joystick should be locked up when not in use, to prevent
unauthorized operation of an AIV.

Figure 8-4. Joystick
The joystick plugs into the left side of the platform, under the small access panel at the upper
right corner of the platform. (The Maintenance Ethernet port is also there.) The access panel is
held in place with a push-push latch, and retained by a lanyard.
CAUTION: The platform safety scanning laser is not tied into the E-Stop
chain when driven using the joystick. The Operator should maintain control of
the joystick and the AIV whenever the joystick is connected to the AIV.
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Joystick Use

Use the joystick to drive the platform manually. Squeeze the trigger to enable the drive button.
Push the drive button forward or back to make the platform move in that direction. Push the
drive button to the side to make the platform rotate in that direction. Diagonal positions of the
drive button move the platform in an arc.
The platform slows to a stop when you release the trigger. To stop more quickly, continue to
squeeze the trigger and pull or push the drive button to its limit in the opposite direction of the
platform’s travel.

8.5 Working with Carts
Goals
The parking goals and the LD Platform Cart Transporters need to be set up in the MobilePlanner software. Refer to Configuration on page 59 for details on MobilePlanner configuration, and
see the Mobile Robot Software Suite User's Guide.

Operation
The transporter locates the cart, couples with it, transports it to the dropoff goal, and
uncouples from the cart, leaving the cart at the dropoff goal while it proceeds to its next
assigned job.

Cart-Locating
If a cart is at a parking goal, the transporter can navigate close enough to the cart for the Latching Mechanism to take over.
The Latching Mechanism pulls the transporter and cart together, which enables a sensor to
detect that they are fully-coupled. Once the coupling sensor is triggered, the transporter will be
able to move the cart.
CAUTION: Pinch hazard. The latch on the transporter can pinch you if you
are not careful. Keep your hands clear of the Latching Mechanism when it is in
action.

CAUTION: Pinch hazard. The coupling action of transporter and cart can
pinch you if you are not careful. Keep your hands clear of the space between
the HMI post and cart when the platform and cart are coupling.

NOTE: If the sensor does not get triggered, the transporter‘s software will prevent it
from moving.

Cart Brakes
The two rear casters of the cart have brakes, which push a blunt pin against the caster rolling
surface to prevent a cart from rolling when it is parked on a floor that is not perfectly level.
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Cart brakes are only intended to prevent rolling on a slightly unlevel floor. They will not immediately stop a moving cart, or prevent a cart from rolling down a slope.
Although it is possible to push the cart with the brakes engaged, this is not recommended
because it will accelerate wear of both the braking pins and the casters themselves. When a
cart needs to be moved, the Operator should always release the brakes with the brake release
handle.
In the unlikely event that the cart becomes unlatched from the platform while in motion, the
brakes are designed to stop the cart within six feet.
Automatic Brake Release

When the transporter couples with the cart, it actuates a lever that releases the cart brakes, so
the cart can move freely with the transporter.
Manual Brake Release

When there is no transporter present, the cart brakes can be released manually. Each cart
comes with a release cable and lever, similar to a bicycle brake handle, that releases the cart
brakes when squeezed. Installation of this cable and lever is covered in Installing the Cart Brake
Release on page 52. As long as the brake release handle is squeezed, the brakes will be released.
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Chapter 9: Options
The LD Platform Cart Transporter is available with a number of options to enhance its performance and abilities.

Enterprise Manager 1100
The Enterprise Manager 1100 manages a fleet of AIVs, for multi-AIV coordination and job
management. It includes the Enterprise Manager appliance running the Mobile Software suite.
It is covered in the Enterprise Manager 1100 User's Guide.

MobilePlanner Software (licensed)
In order to have your LD Platform Cart Transporter perform autonomous mobile activities, you
need to make a map of its operating space, and configure its operating parameters. The
MobilePlanner software is used to make this map and perform this configuration.
Refer to the separate Mobile Robot Software Suite User's Guide for details on how to map a working space and prepare the virtual elements, goals, routes, and tasks for your application.
The MobilePlanner software requires a license to run. You need at least one MobilePlanner
license for each fleet of AIVs. Once a map is generated, it can be shared with multiple AIVs
working in the same space.

Joystick
This is mainly used to drive the platform when doing a scan, in preparation for making a
map of the workspace. You need at least one joystick for each fleet of AIVs. Once a map is generated, it can be shared with multiple AIVs working in the same space.

Spare Battery
At least one spare battery is needed if you opt to swap the platform’s battery, rather than having it charge itself at a docking station. See Manually Charging the Battery on page 133.

Spare Carts
Extra carts can be ordered, because a cart installation can use more carts than transporters.
The part number is 75020-000.
The following options are documented in the LD Platform Peripherals Guide.

Call Buttons/Door Boxes
Call buttons are used to issue a request for an AIV to go to the goal associated with the button.
There may be multiple call buttons, even in an installation where there is only one transporter.
Door Boxes are used to open an automated door, so the AIV can pass through.
See LD Platform Peripherals Guide.
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Acuity Localization
Acuity localization uses an upward-facing camera to localize the platform using overhead
lights, which it compares with lights stored in its map. This can be used in circumstances
where laser localization is difficult, either because the environment has too many changing features or simply not enough features for laser localization. If there are many objects, such as pallets or carts, which change location frequently, they may not be on the platform’s map, and
may also block the laser’s view of features that are on the map. In such cases, Acuity localization may be a better choice than using the safety scanning laser for localization.

High-Accuracy Positioning System
This allows an AIV to achieve accurate alignment at a specific location, typically at a fixed conveyor, using a sensor to detect magnetic tape at that location.
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This chapter covers periodic maintenance and user-serviceable parts replacement for the LD
Platform Cart Transporter.

Operator
Panel
Side Laser, Guard x2
Laser Support
Tube x2
Brace x2

HMI
Post

Rear-facing
Laser, Guard

Navigation
Laser
Low
Front
Laser

Rear
Sonar

Light
Disc x2

Battery
Cover

Figure 10-1. Major LD Platform Cart Transporter System Parts, with Acuity Camera

Top Plate

HMI Post Base

Rear-facing Laser

Coupling
Laser Cover

Operator Panel
Cart Latch

Latch
Position
Sensor

ON/OFF/BRAKE/Key Switch

Touchscreen
Light Pole (Beacon)

E-Stop, LATCH, UNLATCH
Antenna x2
Latching Mechanism Cover HMI Post

Figure 10-2. Top View of an LD Platform Cart Transporter, Side Laser Support Tubes Removed
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10.1 Safety Aspects While Performing Maintenance

Platform Core

Platform
Sonar
Controller

Payload
Bay

Core
Mounting
Bracket

Figure 10-3. Location of Parts in the Payload Bay

10.1 Safety Aspects While Performing Maintenance
Electrical Hazards
DANGER: During maintenance and repair, the power to the docking station
must be turned off. Remove and lock up the power cord to prevent unauthorized third parties from turning on power. The access covers on the docking
station are not interlocked.
DANGER: There are no user-serviceable parts inside the docking station. Do
not remove the covers of the docking station. There is high voltage inside, and
the covers are not interlocked.

DANGER: Only skilled or instructed persons, as defined in the Mobile Robot
LD Safety Guide, should perform the procedures and replacement of parts
covered in this section.

DANGER: During maintenance and repair of the transporter, turn off the
transporter and disconnect the battery as soon as possible. Avoid shorting the
terminals of the battery.

WARNING: Parts of the drivetrain can get hot during operation. Allow the
platform to cool down before servicing.
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Pinch Hazard
Platform Covers

CAUTION: Pinch hazard. The covers are held in place with strong magnets,
which can pinch you if you are not careful. Follow the instructions in the Maintenance chapter for handling covers.

Magnetic Field Hazards
Platform Covers

WARNING: Magnetic fields can be hazardous to medical implant wearers.
Medical implant wearers stay back 30 cm (12 inches) from the covers, which
are held in place with strong magnets.

WARNING: Magnetic fields can be hazardous to medical implant wearers.
Medical implant wearers stay back 30 cm (12 inches) from the underside of the
platform, which is exposed during this maintenance procedure when the platform is tipped on its side.
Docking Funnel

WARNING: Magnetic fields can be hazardous to medical implant wearers.
Medical implant wearers stay back 30 cm (12 inches) from the underside of the
platform, which is exposed during certain maintenance procedures for which
the platform is tipped on its side.

10.2 Lifting the Platform Safely
If, for any reason, you need to lift the platform by hand, take care to lift from safe lifting points.
WARNING: Platform damage. Lifting the platform from the wrong points can
damage the platform.

Front Lifting Points
On each side of the laser, under the upper side of the laser slot. Do not lift at the center - there
is no frame supporting it there. Do not lift anywhere else! Refer to the following illustration:

14766-000 Rev E

LD Platform Cart Transporter User's Guide

143

10.2 Lifting the Platform Safely

Figure 10-4. The upper surface of the laser slot, at both sides, not the center.

Rear Lifting Area
The center underside of the platform, where the cover has a raised section. Do not lift anywhere else! Refer to the following illustration:

Figure 10-5. Bottom of Inner Rear cover. Lift from the frame, not the cover.
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10.3 Safety Inspection
Item

Period

Reference

Warning Devices

1 week

Warning Devices on page 145

Warning Labels

1 week

Warning Labels on page 145

Informative Labels

1 week

Informative Labels on page 148

Warning Devices
The following warning devices should be inspected for proper function on a weekly basis.
Light Discs

The light discs on each side of the transporter should be checked.
Flashing Light(s)

The beacon on top of the HMI post should be checked.
If there is a user-installed beacon or light tower that has been installed to warn people of the
AIV’s movement or imminent movement, it should be checked for proper function every week.
You should ensure that the light remains visible under all operating conditions, so that, regardless of your payload structure design, any people near the AIV can see it.
Buzzer

The warning buzzer should be checked for proper function. In order to maintain conformity
with applicable standards, it is important that the buzzer be audible in all operating conditions and environments.

Warning Labels
See Figure 10-6. and Figure 10-7.
All warning labels on the LD Platform Cart Transporter should be checked on a weekly basis
for being present and legible. If any of the labels are missing or illegible, they should be
replaced. The labels, with part numbers, are:
l

Invisible Laser Aperture Label, 13307-000L

One of these labels will be on the front navigation laser.
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l

Laser Aperture Label, 13308-000L

One of these labels will be on each of these lasers:

l

o

Low Front laser

o

Left and Right Side lasers

o

Rear laser

o

Coupling laser

Pinch Point Label, 12992-000

A pinch point label is on top of the latch mechanism cover.
l

Hand-entanglement Label, 18180-000

A hand entanglement label is under the latch mechanism cover, near the belt and pulley. See Removing Latching Mechanism Cover on page 151 for instructions on removing the
cover.
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l

Medical Implant, Magnetic Field Warning Label, 18621-000

One magnetic field/implant label is on the transporter rear cover.
A second is on the top rear bar of the cart.
A third is on the underside of the transporter, on the docking funnel. This magnet is
only exposed during maintenance, when the transporter is tipped on its side.
l

Yellow circle surrounding the E-Stop, 11229-167
This is labeled EMERGENCY STOP. It is located on the Operator Panel, at the top of the
HMI post.

l

No Riding Label, 18178-000

One of these labels is located on the LD Platform Cart Transporter top plate, near the
front.
Another is on the top rear bar of the cart.
l

No Incline Label, 18179-000

A no incline label is attached on the top plate of the transporter, in front and to the side
of the plastic triangle for aligning with a cart.
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l

Automatic Vehicle Label, 18623-000

CAUTION
AUTOMATIC
VEHICLE
An Automatic Vehicle label is attached to the rear cover of the LD Platform Cart Transporter.

Informative Labels
The following labels are on the Operator Panel, at the top of the HMI post. They should be
checked on a weekly basis for being present and legible. If any of the labels are missing or
illegible, they should be replaced. The labels, with part numbers, are:
l

HMI post button label, 14463-000
This includes the BRAKE, ON, OFF, and Keyswitch labels.

l

HMI post LATCH, UNLATCH button labels, 14628-000

HandPinch
Entanglement Hazard
Label (under
Label
cover)
No Ride
and No
Incline
Labels

E-Stop Button
LATCH,
UNLATCH
Labels

ON,
OFF,
BRAKE
Labels

Laser
Labels

Laser
Labels

Magnetic
Field
Labels
(Underside
of Platform)

Figure 10-6. Locations of Labels on LD Platform Cart Transporter
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Magnetic
Field and
No-ride
Labels

6-mm dia. (0.25-inch dia.) Pass-through
hole for brake cable, through rear frame tube

Figure 10-7. Magnetic Field/Implant, and No Riding Labels on Cart

10.4 Cleaning
Work Area Maintenance
The work area of the AIVs must be kept generally clean and free from clutter that could block
an AIV.
Anything spilled on the floor of the work area, such as dust, ice, pooled water, etc., must be
removed immediately, as this would interfere with the AIV’s ability to drive safely, as well as
navigate. Any substance that reduces the AIV’s traction with the floor will impair its ability to
drive, stop, turn, and navigate. Pay particular attention to areas around goals and frequentlytraveled paths.

LD Platform Cart Transporter and Cart
Some parts of the LD Platform Cart Transporter require periodic cleaning. The following table
gives a summary of cleaning procedures for the LD Platform Cart Transporter system.
Table 10-1. Cleaning
Item

Period

Reference

Clean docking station
contacts

3 months

Docking Station Contacts on page 150

Clean axles and tires

As needed

Tires on page 150

Clean casters

As needed

Casters on page 150

Clean all laser lenses wipe clean

6 months/ as
needed

Lasers on page 150

NOTE: The safety scanning laser will display a flashing icon of a windshield and wiper
when it detects that its lens needs cleaning.
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10.5 Accessing the Payload Bay

NOTE: When the tires or floor get dirty, the wheels will tend to slip, and the AIV
can fail to localize. This is common near goals. Both the floor and the tires need to
be kept clean.
NOTE: The frequency of these procedures will depend on your particular system,
its operating environment, and the amount of usage. Operating in an environment
with a lot of dust or dirt will require more frequent cleaning. Use the intervals in
this section as guidelines, and modify the schedule as needed.

Tires
Occasionally clean the tires with a mild soapy solution. Remove any dirt or debris that may
accumulate on the tires, because these can degrade the AIV’s performance.

Casters
Occasionally clean the casters with a mild soapy solution. Remove any dirt or debris that may
accumulate on them, because these can degrade the AIV’s performance.
This applies to the casters on the LD Platform Cart Transporter as well as on the cart.

Axles
Keep the axles free of hair, string, or anything that may wrap around and bind up the platform’s drive.

Lasers
Occasionally clean the lenses of all lasers. Use only alcohol-based, non-abrasive cleaners, and
wipe thoroughly.

Docking Station Contacts
The two docking station contacts occasionally need to be cleaned. The suggested interval is 3-6
months, depending on frequency of charging.
WARNING: Unplug power from the docking station before cleaning. Remove
the power cord at the docking station.

Clean the contacts with isopropyl alcohol.
CAUTION: Do not lubricate the docking station paddle. Lubrication will
reduce the life of the paddle.

10.5 Accessing the Payload Bay
The payload bay is the area between the platform top plate and the top of the platform itself.
Care must be taken, when accessing the payload bay, that the wires and connections between
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the platform and the HMI post and coupling plate are not damaged. See Top View of an LD Platform Cart Transporter, Side Laser Support Tubes Removed on page 141.
The top plate is held on with eight M6 socket-head screws and two M5 cap screws. You
should not remove the HMI post base. The sheet metal cover of the Latching Mechanism
needs to be removed to access the two M5 screws. The top plate and the rest of the coupling
plate will come off together.
CAUTION: When lifting the top plate off, take extra care not to scratch the
coupling laser’s lens with the top plate itself.

Removing Latching Mechanism Cover
1. Remove the four M3 screws holding the Latching Mechanism cover to the top plate.
These go into four 45 mm standoffs in the top plate.
Retain the M3 screws for reassembly.
2. Lift off the Latching Mechanism cover.
Retain the cover for reassembly.

Removing Top Plate
1. Remove the two stainless M5 screws that were covered by the Latching Mechanism
cover.
Retain the M5 screws for reassembly. These are socket-head cap screws.
2. Remove the eight M6 screws along the sides and front of the top plate.
Retain the M6 screws for reassembly. These are flat head, stainless screws.
3. Disconnect the cables going to the latching assembly and sensors in the Latching Mechanism.
4. Carefully lift off the top plate.
As you remove the top plate:
CAUTION: Take care not to scratch the laser lens when removing the
top plate.

At this point, you will have access to the payload bay.

Installing Top Plate
1. Resintall the top plate.
CAUTION: Take care not to scratch the laser lens when reinstalling the
top plate.
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2. Reconnect the cabling to the latching motor assembly and its sensors.
3. Reinstall the eight M6 screws along the sides and front of the top plate.
Use the screws previously removed from the top plate.
4. Reinstall the two M5 screws that were covered by the Latching Mechanism cover.
Use the screws previously removed from the top plate.

Installing Latching Mechanism Cover
1. Place the Latching Mechanism cover back onto the top plate.
2. Reinstall the four M3 screws holding the Latching Mechanism cover to the top plate.
Use the screws previously removed from the Latching Mechanism cover.
These go into four 45 mm standoffs in the top plate.

10.6 Removing and Installing LD Platform Cart Transporter Covers
Many of the maintenance procedures require removing some of the platform's covers. Most
covers are held in place with just magnets. The rear outer cover has an additional brace at the
bottom for support, the bumper cover uses screws and magnets, and the access panel uses just
a push-push (toggle) latch.
CAUTION: Pinch hazard. The magnets holding the covers in place are strong
enough to pinch you if you are not careful.

The covers are:
l

Rear Inner (Battery)

l

Access Panel

l

Left Side, Right Side
Both side covers include a light disc and cover.

l

Front Upper

l

Bumper

l

Rear Outer

With the exception of the bumper cover, no tools are needed for either the removal or installation of the covers.

Removing Covers
NOTE: After removing covers, place them inner-side down, so the outer surfaces
don't get scratched.
The covers can be removed in the order in which they are listed above.
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l

The rear outer must wait for the rear inner and the two side covers.

l

The front upper must wait for the two side covers.

l

The two sides, the rear inner, and the bumper cover can all be removed without removing any other covers, except that the left cover must wait for the access panel.
NOTE: The light disc covers are not covered here because they are only removed
from the side covers to replace one of the light disc controllers.

Rear Inner Cover (Battery)

This provides access to the battery compartment door.
1. Pull the bottom of the cover away from the platform chassis.
This is easiest if you grip it with two hands, toward the center.
2. Lower the cover down, so its top tab slides down, and clears the rear outer cover.
Access Panel

This provides access to the Maintenance Ethernet and the Joystick ports.
1. Push the left (front) side of the panel in, and the latch will release it.
Pushing the panel a second time will engage the latch.
2. When released, pull the left side out, and slide the panel to the left.
The panel is attached with a lanyard, to prevent getting lost.
You will need to place this panel out of the way when removing the left side cover.
Side Covers

1. For the left side cover, put the access panel out of the way.
2. Pull the bottom of the cover, at both sides, away from the chassis.
3. Work your way up the edges of the cover, pulling it away from the chassis as you go.
4. Remove the cover a few inches from the chassis.
The light disc wires plug into connectors on the inner side of each side cover.
5. Unplug the light disc connector, and move the side cover away from the platform.
Repeat for the other side cover.
Front Upper Cover

This cover is held onto the chassis the most tightly of any of the covers.
1. Grip the cover at the two outer edges.
2. Pry the cover away from the chassis.
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Bumper Cover

This is the only cover that requires tools to remove.
1. Remove the screws at the sides of the cover.
Retain the screws for reinstalling the bumper cover.
2. Pull the cover off of the bumper.
It is held on with magnets, as well as screws.
Rear Outer Cover

This cover houses the two rear sonar pairs, which must be disconnected once the cover is partway off the chassis. Each pair consists of one emitter and one receiver.
1. Pull the top of the cover away from the chassis a few inches.
The cover will pivot on the metal brace at its bottom edge.
2. Pull the four sonar wires, with their connectors, out of the chassis holes.
Refer to the following two figures.

Figure 10-8. Sonar Leads, with Connectors Still in Chassis
3. Unscrew all four sonar connectors.
Ensure that both sides of all connectors are labeled, and match. If not, label them.
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Figure 10-9. Sonar Connectors, with Connectors Exposed
4. Tilt the cover down to about 45°, and slide the brace on the bottom of the cover out of
its clip.
This will separate two pairs of magnets, so you will feel some resistance at first.

Installing Covers
The covers can be installed in the reverse of the order in which they are listed above.
l

The front upper and rear outer covers must be installed first and second.

l

The access panel must wait for the left side cover.

Bumper Cover

This is the only cover that requires tools to install.
1. Place the cover on the bumper.
It is held on with magnets, as well as screws.
2. Install the screws, removed during the cover removal, at the sides of the cover.
Front Upper Cover

1. Grip the cover at the two outer edges.
2. Align the bottom edge of the cover so it slides under the chassis support.
3. Tilt the top of the cover into position.
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Rear Outer Cover

Because this cover houses the rear sonar units, they must be reconnected once the metal brace
across the bottom is in the clip just below the battery access door.
1. Slide the metal brace into the clip in the chassis.
Watch the two magnets on the bottom of the cover, to align them with their mating magnets on the chassis. This is your best guide for getting this cover in its proper place.
These are inboard of the clip holding the brace, so you will have to look on each side of
the cover to check their alignment.
2. When the magnets at the bottom are lined up, tilt the cover up to within a few inches of
the chassis.
3. Pull the sonar connectors clear of the chassis, if they are not already out.
See the preceding figure.
4. Screw the four sonar connectors to their corresponding sonar leads.
Ensure that the labels for the connectors and leads match.
5. Tuck the connectors into the four holes in the chassis, until just an inch of sonar lead is
sticking out.
6. Tilt the top of the cover up to meet the chassis.
Side Covers

1. Move the cover to within a few inches of the chassis, and plug in the light disc connector.
The light disc connector is accessible on the inner side of the side cover.
2. Place the top edge of the cover on the chassis, so the magnets hold it there.
Make sure the gaps on each side of the cover are the same width.
3. Tilt the bottom edge of the cover down.
4. Check each side of the cover to ensure that the cover edges on each side of the gap stick
out the same amount from the chassis.
This is most likely to be uneven near the top of the cover.
5. If either edge sticks out more than the neighboring cover, pull the neighboring cover
away from the side cover slightly, and release.
This should allow the side cover to snap into place, so both sides of the gap stick out
the same amount.
Repeat for the other side cover.
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Figure 10-10. Right Side Cover, Showing Even Gaps at Edges
NOTE: The gaps between the side covers and the bumper cover will be smaller
than the other gaps, and will not be even.
Access Panel

1. Slide the panel to the right, so its tab goes under the left side cover.
The panel is attached with a lanyard, to prevent getting lost.
2. Press the left (front) side of the panel in, and the latch will hold it.
This is a toggle latch - pressing it once engages it, pressing it a second time releases it.
Rear Inner (Battery) Cover

1. Slide the cover up, so its top tab fits under the rear outer cover.
CAUTION: Pinch hazard. This cover is the most likely to pinch you if
you are not careful, particularly at its bottom edge. Hold the cover at the
bottom, in the center, with two hands.

2. Holding the cover near the center, with both hands, tilt the bottom of the cover down,
towards the platform chassis.

10.7 Replacing Periodic Parts
The drive motors and gearbox are sealed and permanently lubricated, so they do not require
periodic maintenance.
Battery Replacement

The battery is expected to last for approximately ≥ 2000 recharge cycles.
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NOTE: There are no serviceable parts inside the battery case. Do not open it.
WARNING: Replace the battery only with an Omron Adept Technologies, Inc.
battery.

Dispose of the battery according to all local and national environmental regulations regarding
electronic components. Contact your local Omron support
WARNING: Follow appropriate ESD procedures during the
removal/replacement phases.

Removal

WARNING: The battery is heavy (19 kg/42 lbs). Observe safe lifting practices
when removing or installing the battery.

1. Remove the inner rear platform cover.
a. Pull the bottom of the cover away from the platform chassis.
This is easiest if you grip it with two hands, toward the center.
b. Lower the cover down, so its top tab clears the rear outer cover.
2. Unlatch and open the battery compartment door, at the back of the platform.
The battery compartment door is capable of being locked. You may need to unlock it
before opening.
3. Disconnect the power and data cables before removing the battery.
See the following figure.
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Figure 10-11. Battery Cable Connectors
4. Slide the battery back and out of the platform.
There is a hand grip at the front and the rear of the battery, to help you lift it.
Installation

Refer to Installing the Battery on page 43 for instructions on installing the battery.

10.8 Replacing Non-Periodic Parts
All of the following parts are replaced on an as-needed basis.

Docking Station Roller and Bearing
WARNING: There are no user-serviceable parts inside the docking station. Do
not remove the covers of the docking station. There is high voltage inside, and
the covers are not interlocked.
The roller, which guides the platform onto the docking station, may be subject to wear after
extended use. The time to replace the roller should be based on your visual inspection and
judgment of when it is too worn. We do not specify a quantitative measure for this.
Refer to the following figure for the location of the roller.
WARNING: Unplug power from the docking station before starting. Remove
the power cord at the docking station.

The roller is held to the docking station with a shoulder bolt.
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1. Remove the shoulder bolt from the center of the roller. Retain the shoulder bolt.
2. Remove the roller and bearing from the docking station.
3. Install the new roller and bearing, using the retained shoulder bolt.

Switch
Roller

Figure 10-12. Docking Station Roller Location

Safety Scanning Laser
If the Safety Scanning Laser needs to be replaced, contact your local Omron support.

Obstacle Detection and Coupling Lasers
All of the lasers on the LD Platform Cart Transporter, other than the Safety Scanning Laser, are
the same model laser. The front of these lasers have two LEDs. Green indicates ready status,
flashing red indicates an error. No LEDs lit indicates no power.
These lasers come with an attached cable, about 0.3 m (12 inches) long, with a male M12 connector.
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Low Front Laser

1. Remove the four M5 screws holding the laser guard to the mounting plate along with
their lock washers and flat washers.
This will free the guard from the plate.
Retain the M5 screws, lock washers, and flat washers for reassembly.
CAUTION: Take care not to scratch the laser lens during this procedure.

2. Remove the two M4 screws, lock washers, and flat washers holding the laser to the
plate.
This will free the laser from the plate.
Retain the two screws, lock washers, and flat washers for reassembly.
3. Disconnect the laser cable from the cable to the platform core.
Cut the cable ties holding the cable to the cable tie anchors.
4. Connect the platform core cable to the new laser’s cable.
5. Mount the new laser to the plate with the M4 screws, lock washers, and washers previously removed.

NOT
USED

Guard, Front

M5

Laser Mount

M4

Chassis

NOT
USED

Guard, Rear,
to Chassis

THRU

NOT USED

NOT USED

Cable Tie Anchors

Cable Tie Anchors

Underside

Top Side

Figure 10-13. Mounting Plate for Low Front Laser and Guard
6. Mount the laser guard to the plate with the M5 screws, lock washers, and washers previously removed.
Take care not to scratch the laser lens during this procedure.
7. Cable-tie excess cable to the two anchors so it cannot touch the floor or the tires.
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Side Lasers

Each side laser assembly includes the laser, guard, and flange. They mount to the ends of the
horizontal support tubes. The flanges should be left attached to the horizontal support tubes.
1. Loosen the two M4 screws holding the laser guard to the mounting flange.
The screws go through two slots in the guard, so the guard can slide off after the screws
are loosened.
2. Slide the guard back enough to free it, and remove it from the assembly.
CAUTION: Take care not to scratch the laser lens when removing the
laser guard.

3. Remove the two M4 screws holding the laser to the mounting flange.
This will free the laser from the mounting flange.
Retain the two screws, flat washers, and lock washers for reassembly.
4. Detach the cable from the old laser.
Do not let the cable slip into the flange or support tube, where you can’t reach it.
5. Attach the cable to the replacement laser.
6. Mount the laser to the mounting flange, using the M4 screws and washers you
removed from the old laser assembly.
7. Mount the laser guard to the mounting flange, sliding its tabs under the M4 screws that
you previously loosened.
Take care not to scratch the laser lens during this step.
Ensure that the laser guard opening faces the front of the transporter.
Tighten the screws to hold the guard in place.
Rear-facing Laser

A rear laser assembly includes the laser, guard, and mounting bracket. The bracket mounts to
the HMI post between the horizontal support tubes.
Replacing this laser requires accessing wires and a connector inside the left horizontal support
tube, which is attached to the HMI post.
1. Remove the two M6 screws, lock washers, and flat washers holding the left laser support tube to the HMI post.
Save the screws and washers for reassembly.
2. Loosen, but do not remove, the two M5 screws securing the support tube to the HMI
base.
3. Loosen the two M4 screws holding the rear-facing laser guard to the bracket.
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The screws go through two slots in the guard, so the guard can slide off after the screws
are loosened.
4. Slide the guard back enough to free it, and remove it from the assembly.
CAUTION: Take care not to scratch the laser lens when removing the
laser guard.

5. Remove the two M4 screws, lock washers, and flat washers holding the laser to the
bracket.
This will free the laser from the bracket.
Retain the two screws, lock washers, and flat washers for reassembly.
6. Carefully twist the left laser support tube on its brace, to expose the cables inside.
Pull out the laser cable, until you have access to the connection between the cable to the
laser, and the cable going down inside the HMI post (to the platform core).
7. Disconnect the laser cable from the cable to the platform core.
Take care that the connector doesn’t slip down inside the HMI post.
8. Connect the new laser cable to the cable from the platform core.
9. Tuck the connector inside the left laser support tube, so that the cable goes through the
small notch in the left support tube flange.
10. Mount the new laser to the bracket with the M4 screws, lock washers, and washers previously removed.
11. Reattach the left laser support tube to the HMI post, using the M6 screws, lock washers,
and washers previously removed.
12. Put the guard over the laser, and slide its tabs under the previously-loosened M4
screws.
Take care not to scratch the laser lens during this step.
Tighten the screws to hold the guard in place.
Coupling Laser

The coupling laser is mounted in the platform‘s payload bay, protruding up through the top
plate, into the coupling plate. It enables the transporter to position itself close enough to a cart
for the Latching Mechanism to couple with the cart.
Remove the Latching Mechanism cover and the platform top plate. Refer to Accessing the Payload Bay on page 150.
1. Remove the two M4 screws holding the laser to the bracket.
This will free the laser from the bracket.
Retain the two screws, flat washers, and lock washers for reassembly.
2. Disconnect the laser cable from the cable to the platform core.
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3. Connect the new laser cable to the cable going to the platform core.
4. Mount the new laser to the bracket with the M4 screws, lock washers, and washers previously removed.
Reinstall the top plate and the Latching Mechanism cover. Refer to Accessing the Payload Bay on
page 150.

Rear Sonar Units
The platform's four rear sonar units can be replaced individually. All four sonar units are
identical, although two are used as emitters and two as receivers, in pairs.
1. Remove the inner and outer rear covers from the platform. Refer to Removing and
Installing LD Platform Cart Transporter Covers on page 152.
2. Unscrew the connection between the sonar cable and the sonar unit's lead.
Ensure that both the connectors and leads are labeled, and match. If not, label them.
3. Compress the two flat springs holding the sonar unit, and remove it from the cover.
Press the new sonar unit through the hole in the rear outer cover, from the outside.
4. Connect the sonar cable to the new sonar unit's lead.
5. Insert the new sonar unit through the hole in the rear outer cover.
6. Reinstall the rear covers.

Sonar Controller
The sonar controller is located in the payload bay.
1. Refer to Accessing the Payload Bay on page 150 to access the payload bay.
2. Locate the sonar controller.
l

l

The controller is plugged into the Sonar 1 connector on the LD Platform core.
This connector is not accessible from the payload bay, but does not need to be
unplugged for this procedure.
The controller will be at the very front of the payload bay, screwed into the payload bay deck with two screws.

a. Unscrew the controller from the payload bay deck by removing two screws.
Retain the screws for mounting the replacement controller.
b. Unplug the larger cable from the sonar controller.
Be careful not to let the cable end slip into the chassis.
c. Unplug the sonar unit cables from the controller.
These are the smaller cables that go to the individual sonar units.
Make sure these are labeled and tied up, so they can't slip into the chassis.
d. Remove the controller from the payload bay, and replace it with the new one.
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e. Connect the sonar unit cables to the new controller.
Ensure that the cable labels match the controller labels.
f. Plug the larger cable into the new controller.
g. Screw the new controller to the payload bay deck, using the two screws removed
from the old controller.
3. Reinstall the platform top plate and Latching Mechanism cover. Refer to Accessing the
Payload Bay on page 150.
4. Dispose of the old controller according to local and national regulations concerning electronic components.

Cart Latching Mechanism
CAUTION: The latch mechanism belt adjustment is for Omron Adept Technologies, Inc. Field Service only. Changing the belt tension can lead to premature failure.

The acetal end of the Latching Mechanism is subject to wear, and may need replacement.
When the acetal on the cart Latching Mechanism has worn through a quarter of its original
thickness, or when either of the two screws holding the acetal block in place becomes flush
with the acetal block, the block needs to be replaced.

Cart
Latch
Hook
Acetal
Block

Latch
Motor

Belt and Pulley
Figure 10-14. Cart Latch Mechanism with acetal block, Vertical Position
NOTE: The color of the acetal block may vary.
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CAUTION: Pinch hazard. The latch of the LD Platform Cart Transporter can
pinch you if you are not careful. Keep your hands clear of the Latching Mechanism when it is in action.

WARNING: Entanglement hazard. The belt and pulley of the LD Platform
Cart Transporter can entangle your hand during maintenance. Keep your
hands clear of the belt and pulley when they are moving. This is only a hazard
during maintenance of this part of the LD Platform Cart Transporter.
1. Remove the latching mechanism cover.
See Removing Latching Mechanism Cover on page 151.
2. Rotate the cart Latching Mechanism up on its pivot:
In order to replace the acetal block, the cart latch hook has to be rotated up to its vertical
position. If the hook-lowering block shown in the following figure is removed, the latch
hook will be pulled up to its vertical position.

Hook
Acetal
Block

Screws

Hook-lowering block

Figure 10-15. Hook-lowering Block and Screws
l

Remove the two screws holding the hook-lowering block in place.
Retain the screws for re-assembly.

l

Remove the block, allowing the latch hook to spring up.
Retain the block for re-assembly.

3. Unscrew the two screws holding the acetal block on the end of the latch hook.
These were installed with threadlocker.
Retain these screws for attaching the replacement acetal block.
4. Remove the acetal block, and replace it with the new block.
5. Attach the new acetal block with the two screws previously removed.
Use Loctite® 222MS (blue) on the screws.
6. Reinstall the hook-lowering block.
l
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hook in the down position.
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l

Insert the two screws previously removed to hold the hook-lowering block in
place.

7. Reinstall the latching mechanism cover.
See Installing Latching Mechanism Cover on page 152.

Light Discs
The two light disc assemblies and their controllers are single units, so replacing a controller
also replaces all of the lights on that side of the platform.
1. Remove the side cover, on the side that needs the light disc assembly replaced.
Refer to Removing and Installing LD Platform Cart Transporter Covers on page 152.
2. Unscrew the four screws holding the light disc PCA to the side cover.
Retain the screws and round cover for installing the new assembly.
3. Remove the light disc PCA.
4. Screw the new assembly and retained round cover to the side cover, using the screws
retained from the old assembly. The PCA is keyed so that it can only be installed in one
orientation.
5. Reinstall the side cover, connecting the cable to the new light disc PCA.
6. Dispose of the old light disc PCA according to local and national regulations concerning electronic components.

Wheels and Tires
The wheels and tires should be checked every 3 months. If they show signs of cracking, excessive wear, or any damage they should be replaced. Refer to the following figure.

Figure 10-16. Samples of Tire Wear
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The wheels/tires are not user-serviceable parts. If the tires are worn or cracked, contact your
Omron sales representative.

Drive Assemblies
The platform drive assemblies have been designed to be field-replaceable. This will replace the
drive motor, gearbox, encoder, and wheel/tire assembly.
Removal

1. Remove the inner rear cover.
2. Unlatch and open the battery compartment door, at the back of the platform.
The battery compartment door is capable of being locked. You may need to unlock it
before opening.
3. Disconnect battery power by unplugging the two cables at the rear of the battery.
4. Remove the side cover a small distance from the platform on the side where you want
to replace the drive assembly. Refer to Removing and Installing LD Platform Cart Transporter Covers on page 152.
The light disc PCA cable will still be attached.
5. Disconnect the cable from the light disc PCA, so the side cover can be moved completely away from the platform.
This will expose the drive assembly.
6. Lift the drive wheel up, compressing its springs, enough so that you can insert a Ø6 x
10 mm (0.24 x 0.4 inch) pin into the hole on the rear side of the assembly (there is a
hole on each side). This will keep the springs compressed (the wheel will be in the up
position), and make removal easier. An M5 x 10 screw works well for this. If you saved
the wheel pin, it should be used for this. See Figure 3-9. See also Chapter 10:
7. The drive assembly is held in place with three nuts on studs across the top, and two
pairs of screws at each side, near the bottom of the assembly.
Remove the three nuts and four screws (and their washers) holding the drive assembly
to the platform.
Retain these nuts, screws, and washers for attaching the new drive assembly.

Figure 10-17. Mounting Studs and Nuts at top of Drive Assembly
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Figure 10-18. Mounting Screws at Bottom-Right of Drive Assembly
8. Remove the drive assembly from the platform.
The motor cable to the LD Platform core will still be attached.
9. Disconnect the motor cable at the drive assembly.
Installation

1. Lift the new drive wheel up, compressing its springs, enough so that you can insert a 6
x 10 mm (0.24 x 0.4 inch) pin into the hole on the rear side of the assembly (there is a
hole on each side). This will keep the springs compressed (the wheel will be in the up
position), and make installation easier. If you saved a wheel pin when you uncrated the
platform, you can use that. An M5 x 10 screw also works well for this. See Maintenance
on page 141.
NOTE: Make sure that the pin is short enough so that you can pull it out
after the assembly is in place.
2. Connect the motor cable to the new drive assembly.
3. Install the new drive assembly over the three studs at the top of its bracket.
Use the nuts, screws, and washers you removed from the old drive assembly.
4. Remove the pin or screw you used to hold the wheel in the up position.
5. Put the side cover next to the platform, and attach the cable to the light disc PCA.
6. Reinstall the side cover.
7. Connect the battery power and data cables, and close the battery compartment door.
8. Reinstall the rear cover.

Platform Casters
The platform casters should be checked every 3 months. If they show signs of cracking, excessive wear, or any damage they should be replaced.
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All four platform casters are identical, and are mounted to the platform in the same way.
NOTE: If you have a means of lifting the chassis of the platform enough to access
the screw that holds on the caster, you can avoid removing the battery, which is
only necessary to tilt the platform on its side.
If you cannot lift the chassis enough to access the caster screw:
1. Remove the inner rear cover.
2. Unlatch and open the battery compartment door, at the back of the platform.
The battery compartment door is capable of being locked. You may need to unlock it
before opening.
3. Disconnect the battery by unplugging the two cables at the rear of the battery.
4. Remove the battery from the platform.
5. Remove the side covers.
6. Lay the body of the platform on its side, exposing the casters.
WARNING: Magnetic fields can be hazardous to medical implant wearers. Medical implant wearers stay back 30 cm (12 inches) from the
underside of the platform, which is exposed during this maintenance
procedure when the platform is tipped on its side.
Whether or not you had to remove the battery:
1. Remove the M10 x 30 mm screw holding the caster to the platform.
The screw was installed with Loctite 263.
Retain the screw for attaching the new caster.

4x M6 x 22 Screw,
Flat Head Socket

Use Loctite 263 on
the M10 x 30 Screw

Caster, Heavy Duty,
with Bolt Hole Fitting

M10 x 30 mm Screw,
Flat Head Socket

Completed Assembly

Figure 10-19. LD Platform Cart Transporter Caster Replacement
2. Remove the caster from the platform.
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3. Put the new caster in place, and attach with the M10 x 30 mm screw you removed from
the old caster.
Use Loctite 263.
Torque to 27 N·m (20 ft·lbf).
If you removed the battery for this procedure:
1. Return the platform to its upright position.
2. Reinstall the battery, connect the power and data cables, and close the battery compartment door.
3. Reinstall the inner rear cover.
4. Reinstall the side covers.

LD Platform Cart Transporter Casters
The cart casters should be checked every 3 months. If they show signs of cracking, excessive
wear, or any damage they should be replaced.
Front Caster Removal

The two front casters are identical, and are mounted to the transporter in the same way.

Figure 10-20. Front Cart Caster Screw Assembly
1. Remove the M10 screw and washer holding the caster to the cart.
Threadlocker was used on this screw during assembly.
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Retain the screw, washer, and lock washer for mounting the new caster.
2. Remove the caster from the cart.
Front Caster Installation

1. Put the new caster in place, and attach with the M10 screw and washers you removed
from the old caster.
Use Loctite 263 on the screw.
2. Torque to 73.2 N·m (54 ft-lbf).
Rear Caster Removal

The two rear casters are the same as each other, but different from the front casters, due to the
fact that the rear casters have brakes.
1. Remove the top plate of the cart. See Removing Top Plate on page 151.
2. Unscrew the lock nut from the axle screw going through the caster wheel.
3. Remove the axle and caster wheel.
The axle screw, lock nut, and caster wheel can be discarded.
4. Loosen the outer brake-adjust jam nut at the actuator bar for the caster you are replacing.
See Figure 10-22.
Lift the cable and brake-adjust assembly out of the slot in the actuator bar.
5. Push the inner wire into the brake cable housing until the brake pin, which presses
against the caster wheel surface, slides out of the caster mounting screw.
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Brake Cable Wire,
with Ball End, Fits
into Slot and Hole
Shaft of Pin Slides
Inside Caster
Mounting Screw
Flat Top of
Blunt End
Retains Spring

Blunt End Presses
Against Caster Wheel
Figure 10-21. Brake Pin
6. Remove the brake pin with spring from the inner brake cable wire.
Save the brake pin and spring for reassembly.
7. Pull the brake cable inner wire up far enough to be out of the way for removing the
caster mounting screw.
8. Unscrew the caster mounting screw, to remove the caster assembly from the cart body.
Retain the caster mounting screw and lock washer for mounting the new caster.
Rear Caster Installation

1. Unscrew the lock nut from the axle going through the new caster wheel.
Retain the lock nut for reassembly.
2. Remove the axle and caster wheel from the caster. Do not discard.
Retain the axle and caster wheel for reassembly.
3. Attach the caster body to the cart body using the caster mounting screw and lock
washer previously removed.
Take care not to damage the brake cable inner wire.
NOTE: Do not use threadlocker on the rear caster mounting screws.
Torque to 73.2 N·m (54 ft-lbf).
4. Push the brake cable inner wire back into the cable housing, so the ball end slides out of

14766-000 Rev E

LD Platform Cart Transporter User's Guide

173

10.8 Replacing Non-Periodic Parts

the caster mounting screw.
5. Make sure the spring, previously removed from the brake pin, is in place on the brake
pin. The wide end goes up, against the caster mounting screw.
6. Insert the ball end of the inner wire into the hole in the brake pin, with the inner wire in
the slot above the hole.
7. Slide the brake pin up inside the caster mounting screw, and hold it in place for the
next step.
8. Install the caster wheel into the caster frame with the axle screw.
Fasten with the lock nut, previously removed.
Torque the lock nut to 41 N·m (30 ft-lbf). Ensure that the wheel spins freely.
The wheel will hold the brake pin inside the caster mounting screw, so it can’t fall out.
9. Pull the inner wire of the cable through the actuator bar, and lock in place with the jam
nut previously removed. Use Loctite 242 on the jam nut.

Cart Brake Release
Refer to the following figure for replacement and adjustment.
The Cart Brake Release consists of the lever cable with handle, and the caster brake system.

Right
Brake
Cable
Right
Brake
Adjust.

Lever
Cable

Pulley

Lever
Cable
Clamp

Left
Brake
Cable

Actuator Bar
Hard Stop

Actuator
Bar

Left
Brake
Adjust.

Lever Cable Anchor

Figure 10-22. Internal Brake-Release Mechanism
Replacing Brake Lever Cable

To replace the cart brake-release cable:
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1. Remove the cart top plate. See Removing Top Plate on page 151.
2. Disconnect the end of the cable from the brake control mechanism.
a. Disconnect the inner wire from the lever cable clamp.
b. Disconnect the lever cable from the lever cable anchor.
3. Feed the lever cable out through the hole in the horizontal back bar of the cart.
You will need to cut the cable tie at the saddle.
4. Disconnect the brake-release lever from its mounting place.
This will vary, depending on how and where you mounted it.
Adjusting the Lever Cable

The brake lever cable needs to be adjusted so there is no excess slack, but so the brakes are
engaged when the lever is not being actuated.
The brake lever cable should be adjusted at the lever cable clamp, shown in the prededing figure. There should be just enough slack so the actuator bar touches its hard stop.
Adjusting the Caster Brake Cables

The two caster brake cables are adjusted at the factory. They will normally not need to be adjusted by the user.
If any adjustment is needed, refer to the preceding figure for the adjustment location. The brake
pins should be able to go down as far as the caster surface allows, without any slack.
After the caster cables are adjusted correctly, ensure that the actuator bar just touches its hard
stop. This will keep the actuator bar in position if you have to adjust the lever cable.

LD Platform Core
The LD Platform core is an enclosed unit, with internal fans as the only moving parts.
1. Access the payload bay. Refer to Accessing the Payload Bay on page 150.
2. Remove the inner rear cover.
3. Unlatch and open the battery compartment door, at the rear of the platform.
The battery compartment door is capable of being locked. You may need to unlock it.
4. Disconnect the battery power and data cables from the rear of the battery.
5. Disconnect all of the cables that are attached to the top portion of the LD Platform core.
Refer to Standard Platform Connections on page 86.
6. Remove the core mounting bracket from around the LD Platform core.
This is two pieces, held in place with four screws down into the chassis, with four more
going sideways into the LD Platform core itself. Retain all of these screws for installing
the new LD Platform core.
See the following figure:
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Figure 10-23. Core Mounting Bracket
7. Remove the Sonar 1 cable from the core.
This cable is too short to allow the core to be lifted, until the cable is removed.
8. Gently lift the LD Platform core up, until you have access to the internal connections.
9. Remove all of the cables that are attached to the internal LD Platform core connector
panel.
The Left Motor and Right Motor connectors use the same type of plug, and can be inadvertently reversed. Ensure that you can identify the left from the right.
See Internal LD Platform Core Connections on page 101.
10. Remove the old LD Platform core.
11. Connect all of the cables that were attached to the internal LD Platform core connector
panel to the new core internal connector panel. See Figure 6-12.
Wait until after the next step to reconnect the Sonar 1 cable.
12. Put the core into the chassis.
13. Connect the Sonar 1 cable to the core.
14. Install the core mounting brackets around the new LD Platform core.
Using the screws and washers you removed from the old core, put four screws into the
sides of the LD Platform core, with four more going down into the platform chassis.
15. Reconnect all of the cables to the top portion of the LD Platform core.
Refer to Standard Platform Connections on page 86.
16. Reconnect the battery power and data cables to the battery.
17. Close and latch the battery compartment door.
18. Reinstall the inner rear cover.
19. Reinstall the platform top plate and Latching Mechanism cover.
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Refer to Accessing the Payload Bay on page 150.
20. Dispose of the old core according to local and national regulations concerning electronic
components.

E-Stop and Safety Laser Commissioning
Under normal circumstances, the AIV is commissioned at the factory, and will not need to be
re-commissioned. However:
l

l

l

l

If the core gets replaced, it will be necessary to redo the E-Stop Commissioning and the
Safety Laser Commissioning procedures.
If the hardware detects a failure, the AIV may automatically decommission itself, and
the AIV will have to be re-commissioned to recover. In this event, ARAM will display a
fault popup in MobilePlanner.
If you are using a user-supplied E-Stop.
Some customers have expressed a desire to perform the commissioning procedures on a
regular basis as part of their preventive maintenance process.
NOTE: After performing either of these tests, you can access the other test by clicking Next Test on the final screen.

E-Stop Commissioning

This procedure verifies that the E-Stop circuitry is triggered when the E-Stop button is pressed.
This is verified by ensuring that you hear the brakes activate after pressing the E-Stop button.
1. Ensure that the E-Stop button is NOT depressed before starting.
2. From the MobilePlanner software, select:
Main Menu > Robot > Safety Commissioning
3. Follow the on-screen instructions to complete the test. You can print a certificate after
successful completion of the commissioning.
Safety Laser Commissioning

This procedure verifies that the safety scanning laser reports speed zone information correctly,
and that the E-Stop circuitry is tripped when an obstacle that should be detected by the laser is
placed in front of the AIV. The speed zones are listed in the following table. (When you press
the Drive button in the wizard, the wizard will display the maximum AIV speed.)
Maximum Speed (mm/s)
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Zone

LD-105CT

LD-130CT

0

225

150

1

450

300

2

675

450

3

900

600
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Maximum Speed (mm/s)
Zone

LD-105CT

LD-130CT

4

1125

750

5

1350

900

6

1350

900

7

1350

900

1. From the MobilePlanner software, select:
Main Menu > Robot > Safety Commissioning
2. Follow the on-screen instructions to complete the test. You can print a certificate after
successful completion of the commissioning.
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11.1 Dimension Drawings
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Figure 11-1. Overall LD Platform Cart Transporter Dimensions

Figure 11-2. Coupling Plate Dimensions, Arms Removed
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8x M6 Threads

234.44

295.4

254
234.44

234.44

234.44

254

254

254

845.82

480.06

591.82

Units in mm

Figure 11-3. Cart Dimensions
If you have a factory-supplied cart, these preceding dimensions show where you will attach
your payload.

11.2 Specifications
LD Platform Cart Transporter Physical
Description

Specification

Physical
Overall Length (with HMI post)

894 mm

Width (at side lasers)

1073 mm

Height (body)

383 mm

Overall Height (with HMI post)

1393 mm

Weight (with battery)

81 kg (179 lb)

Body clearance

50 mm

Rating
IP Rating

180
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Description
Cleanroom rating

Specification
Fed Class 100, ISO Class 5

Suspension
Drive wheels

2 grey non-marking foam-filled rubber

Wheel diameter

200 x 50 mm nominal

Brakes

2 (one each axle)

Steering

Differential

Passive Casters

2 front, 2 rear, spring-loaded

Caster diameter

75 mm nominal

LD Platform Cart Transporter Performance
Description

Specification

Performance
Max payload

LD-105CT: 105 kg (231 lb)
LD-130CT: 130 kg (287 lb)

Run-time

15 h continuous, approx.

Swing radius

Platform or Platform and Cart:
698.5 mm

Turn radius

0 mm

Translational speed, max

LD-105CT: 1350 mm/s (53.1 inches/s)
LD-130CT: 900 mm/s (35.4 inches/s)

Traversable step

5 mm with cart, 130 kg

Traversable gap

5 mm with cart, 130 kg

WARNING: The LD Platform Cart Transporter with a cart is capable of driving over a gap or step of 5 mm (0.2 inch) at a speed of
250 mm/s, but this should not be regarded as normal use. Regular driving over such gaps or steps will shorten the lifespan of the
drivetrain components.
Minimum floor flatness

FF25 (based on the ACI 117 standard)

NOTE: ACI 117 is the American Concrete Institute’s standard for
concrete floors. FF is flatness, FL is the level. Higher FF numbers represent flatter floors. FF 25 is a fairly lenient specification.
Battery

14766-000 Rev E

Run-time

15 hours, approx., no payload

Duty cycle

80%
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Description

Specification

Weight

19 kg (42 lb)

Voltage

22-30 VDC

Capacity

72 Ah

Energy

1.84 kWh nominal

Recharge time

4 h, approx.

Life span

Approximately ≥ 2000 Cycles

Sensors
Safety Scanning Laser

1 at front of platform, 201 mm (7.9 inches)
height
240°, 15 m range, Class 1, eye-safe
PLd Safety per ISO-13849

Side Lasers

2 on horizontal tubes of HMI post
270°, 4 m range, Class 1, eye-safe

Low Level Laser

1 at front of platform, in bumper
270°, 4 m range, Class 1, eye-safe

Coupling Laser

1 on platform deck, passing through the top
plate into the coupling plate
270°, 4 m range, Class 1, eye-safe

Rear-facing laser

1 on HMI post
270°, 4 m range, Class 1, eye-safe

Sonar
(Each pair is one emitter and one
receiver)

2 pairs at rear of platform, 2 m range

Bumper

1 at front of platform, triggers 4 sensors

Position encoders

2 encoders (one each wheel)
2 Hall sensors (one each wheel)

Analog gyroscope (core)

320°/s max rotation

Acuity localization (option)

1 camera on HMI post Operator Panel

Battery Output
Nominal

182

Qty

Actual

Maximum
Current

Description

5 VDC

1

5±5% VDC

1A

Switched Aux power

12 VDC

1

12±5% VDC

1A

Switched Aux power

20 VDC

1

20±5% VDC

1A

Switched Aux power

22 – 30 VDC

2

battery

4A

Switched
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Actual

Maximum
Current

Nominal

Qty

Description

22 – 30 VDC

1*

battery

10 A

Switched

22 – 30 VDC

1*

battery

10 A

Safe, Switched

* 10 A Switched and 10 A Safe, Switched share the 10 A of current.

Cart
Description

Specification

Physical
Length

592 mm

Width

846 mm

Height

480 mm

Weight

23 kg (50 lb)

Rating
Caster ESD

ESD rated

Suspension
Passive Casters

2 front, 2 rear, spring-loaded

Caster diameter

100 mm (4 inches) nominal

Caster Brakes

2 rear casters

Docking Station
Description

Specification

Current

8 A, thermal fuse built into power switch

Contacts

2

Voltage

100 to 240 VAC, 50 to 60 Hz

Power consumption

800 W

Short circuit current
rating (SCCR)

1500 A

Humidity

5% to 95% non-condensing

Temperature

5 to 40°C (41 to 104°F)

Dimensions - WxDxH 349 x 369 x 315 mm
with Floor plate
495 x 495.5 x 317 mm
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Weight

8.2 kg (18 lb)

Mounting

Directly to floor, wall bracket (included), or on floor
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Description

Specification
(free-standing) with included floor plate

184

Indicators

Power on - blue
Charging - yellow

Connector

For out-of-platform battery charging
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